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~ 
GS Paint really does have a plus. In fact, it has two of them - color 
and animation. You can use sixteen colors in a single picture, and 
you can choose those sixteen from a palette that contains 4096 
colors in all. You can also create a series of pictures that show an 
image changing or moving, and GS Paint will animate the series 
automatically. 

You can start using GS Paint in no time. The screen represents the 
easel on which your tools, paints, and canvas are laid out. You use a 
mouse to paint with, and you need only point to the tools, colors, 
patterns, and functions you want to use to select them. 

GS Paint is full of possibilities. There are fifteen tools for you to paint 
with. You can enlarge sections of a picture to work on the details. 
You can choose new colors for the palette and save palettes you've 
created for future use. You can create new patterns any time you 
want - and there's no limit to the number you can have on the 
screen. You can mix colors and patterns together. You can add text 
to a picture in a variety of typefaces, type styles, and type sizes. 

You can arrange and rearrange a picture in all sorts of ways. You can 
reorient images by rotating and flipping them. You can cut and paste 
images from one part of a picture to another or from one picture to 
another. 

When you finish a GS Paint creation, you can of course print it or 
save it on a disk You can also use it to illustrate a document created 
with GS Write from Personal Choice Software, or turn it into an 
animated sequence or slide show. 



Introduction 

J How to Use this Guide 

This guide has four sections. 

"A Guided Tour of Paintworks Plus" takes you through all the basic 
features of Paintworks Plus. It makes many stops along the way to 
let you experiment with the program and become familiar with how 
it works. 

"Shortcuts" describes some alternate ways to use many of the 
functions of Paintworks Plus. You'll find that once you're familiar 
with Paintworks Plus, these shortcuts can save you time and effort. 

The "Reference" section covers every aspect ofPaintworks Plus. It's 
the place to find anything that isn't covered in the guided tour. The 
"Reference" is organized by the way things appear on the screen: 
the tool, border, and color/pattern palettes are illustrated an.d 
explained, and the menu functions are listed according to the menu 
they appear on. 

The "Glossary" lists and defines special terms used in the guide that 
you may not be familiar with. 

What You'll Need 

• A blank disk. It's always best to save the pictures you create 
on a disk other than the GS Paint program disk. 

• A printer, if you want to make printed copies of the pictures 
you create. 

• Imagination. What you can create with GS Paint is limited 
only by your invention. 
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Using the Mouse 

This guide uses four terms to designate the different ways you can 
use the mouse. Here's what the terms mean: 

Click means position the pointer and then press and quickly release 
the button on the mouse. 

Double-click means position the pointer and then press and quickly 
release the mouse button twice. 

Drag means position the pointer and hold the mouse button down 
while you move the mouse. You release the mouse button to choose 
a menu item or to place an object in a picture. 

Press means position the pointer and then hold down the mouse 
button without moving the mouse. 

The Command Ktry 

Throughout this guide, keys are referred to by the name printed on 
them. This key 

is called the command key. 



Introduction 

A Note on Type Styles 

In this guide, boldface type is used for words and messages that 
appear on the screen. Boldface is also used for words you're 
supposed to type or keys you're supposed to press. For example, 

Press delete 

means that you're to press the key that ha& the word delete printed 
on it. 

A Note to the Adventuresome 

If you'd prefer to explore GS Paint on your own instead of 
working through the guided tour in the first six chapters, 
there's no reason not to. GS Paint is simple and straightforward 
and works the way you'd expect it to. 

But don't overlook the "Shortcuts" section of this guide (pages 
75- 82). It describes easy ways to get things done. In the 
"Reference" section (pages 83-134) you'll find an explanation of 
every item in every menu - just in case you need help. 
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A Look Around the Studio 

Starting GS Paint 

There are two ways to start GS Paint. Which one you use depends 
on whether yOur computer is off, or it's on and the launcher is on 
the screen. (The launcher shows you a list of the files on the disk in 
the disk drive and lets you choose the one you want to start.) 

Note: Don't use a RAMdisk with GS Paint. 

q the computer is off: 

1. Turn on the monitor - but not the computer. 

2. Put the GS Paint disk in the disk drive with the label side up. 

3. Turn on the computer. The launcher starts loading into the 
computer. After a few moments, the launcher appears on the 
screen. It looks like this: 

Select the file you want to open: 

1:51 / GSPaint / 

DAnimation if <. Disk 

DSystem 't 

I ~ 
Open ~ 

" U<;~d' 

( lancel 
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4. Find GS Paint on the list. If you don>t see it, use the mouse to 
position the tip of the pointer (the black arrow) on the down 
arrow (at the bottom of the list). Click the mouse button to 
scroll the list up until you find GS Paint. 

S. Position the tip of the pointer on GSPaint and click the mouse 
button. The name is highlighted (it turns from black on white to 
white on black). 

6. Position the pointer on the Open button and click the mouse 
button. GS Paint starts loading into the computer automatically. 

After a minute or two, the easel appears. It looks like the illustration 
on page 7. 

If the launcher is on the screen: 

1. The screen looks something like this: 

Select the file you want to open: 

o ! GSPaint ! 

ORnimation if ( 

OSystem '"' I ~ " ...... 

', ..... 

( 

Disk 

Open ~ ...... 
" 

UG~P .. / . ........ 

Cancel ) 

If the GS Paint disk isn't in the drive, eject the disk that's there and 
replace it with the GS Paint disk, label side up. Then position the 
pointer on the Disk button and. click the mouse button In a 
moment, a new list of names appears on the screen. 
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2. Find GS Paint on the list. If you don't see it, use the mouse to 
position the tip of the pointer (the black arrow) on the down 
arrow (at the bottom of the list). Click the mouse button to 
scroll the list up until you find GS Paint. 

3. Position the tip of the pointer on GS Paint and click the mouse 
button The name is highlighted (it turns from black on white to 
white on black). 

4. Position the pointer on the Open button and click the mouse 
button. GS Paint starts loading into the computer automatically. 

After a minute or two, the easel appears. It looks like this: 

Tool 
Palette 

Border 
Palette 

" File Edit Goodies Color Font 

Color/Pattern Palette 

GS Paint is now ready for you to use. 

/Menu Bar 

Window 
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TbeEasel 

The easel has displayed on it everything you'd expect to find in an 
artist's studio: a blank canvas; a pencil, paintbrush, and other tools; 
and a palette of colors and patterns. It also has a menu at the top 
that lets you print and save pictures, make copies of them, mix 
colors and create patterns, choose fonts, and animate your pictures. 

The Pointer. Move the mouse around. By moving the 
mouse, you also move the pointer around the easel. 
You'll notice that when you move the pointer into the 
drawing window, it changes to a pencil. 

The small picture that's used to represent the pencil­
both in the drawing window and in the tool palette - is 
called an icon. 

The Tools. Whenever the pointer is in the drawing window, it 
takes a shape that fits the tool you've selected. The illustration on 
the next page identifies each of the tools and explains its use. 
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Lasso 

Hand 

Paint Bucket 

Paintbrush 

Straight Line 

Hollow Rectangle 

Hollow Rounded Rectangle 

Hollow Oval 

Hollow Free-form Shapes 

Hollow Polygon 

Marker Box 

Text 

Spray Can 

Pencil 

Eraser 

Filled Rectangle 

Filled Rounded Rectangle 

Filled Oval 

Filled Free-form Shapes 

Filled Polygon 

Lasso. Select an image and lift it off its background to move, copy, 
or cut it. 

Marker Box. Select an area along with its background to move, 
copy, or cut it. 

Hand. Move a drawing around in the window. 

Text. Activate the keyboard so you can add text to a picture. 

Paint Bucket. Fill outlined or solid areas with a color or pattern. 

Spray Can. Spray a color or pattern. 

Paintbrush. Paint with a color or pattern in any of 32 brush 
shapes. 

Pendl. Draw a thin line in a color or pattern. 



A· Look Around the Studio 

Straight Line. Draw a straight line; its color (or pattern) and 
width match the line selected on the border palette. 

Eraser. Erase whatever you drag it over. 

Hollow Rectangle. Draw the outline of a rectangle or square. 

Filled Rectangle. Draw a rectangle or square filled with a color or 
pattern. 

Hollow Rounded Rectangle. Draw the outline of a rectangle or 
square with rounded corners. 

Filled Rounded Rectangle. Draw a rounded rectangle or square 
filled with a color or pattern. 

Hollow Oval. Draw the outline of an oval or circle. 

Filled Oval. Draw an- oval or circle filled with a color or pattern. 

Hollow Free-form Shapes. Draw a closed outline of any shape. 

Filled Free-form Shapes. Draw any closed shape filled with a 
color or pattern. 

Hollow Polygon. Draw the outline of a polygon. 

Filled Polygon. Draw a polygon filled with a color or pattern. 

All hollow shapes match the color ( or pattern) and width of the line 
selected on the border palette. 

All filled shapes are filled with the selected color (orpattern) and 
have an outline matching the color (or pattern) and the width of the 
line selected on the border palette. 
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When you start GS Paint the pencil is always selected. The icon of 
the tool that's selected in highlighted - it's white on black, rather 
than black on white as all the other tools are. 

Here's how you select a tool: 

Move the pointer so the tip of the arrow is in the box with the 
paintbrush. 

Click the mouse button. 

The icon is highlighted. The paintbrush is now selected. 
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The Border Palette. The border palette has four different line 
widths you can choose from. The thinnest line is the same width as 
the line you draw with the pencil. The other lines are two, three, 
and four times as wide. The line width with the check beside it is 
the one that's selected. To select a line width, you point to the line 
you want and click the mouse button . 

.../--. --

-
The border palette controls the width of the straight line tool and 
the width of the outline of all the shapes (hollow and filled 
rectangles, hollow and filled ovals, hollow and filled free-form 
shapes, and hollow and filled polygons). It doesn't affect the 
paintbrush or the pencil in any way. 

You can change the border lines to a color or pattern. How to do so 
is explained under "Border Palette" in the "Shortcuts" section. 
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The Color/Pattern Palette. The color/pattern palette contains the 
colors and the patterns you have to choose from in creating a 

. picture. 

~J~,,~::::WiM:,:,Wu~d ~ 
Selected Color or Pattern 

Color of the Background 
Color or Pattern of Borders 

The color in the large box at the left end of the palette contains the 
color or pattern that's currently selected. You select a color or 
pattern by pointing to it and clicking the mouse button. 

You can choose different colors and create new patterns for the 
palette. "Changing Patterns" and "Choosing Colors for the Palette" in 
Chapter 6, "Advanced Techniques," explain how. 
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The Drawing Window. The drawing window frames the easel's 
working area. 

/Close Box /Title Bar 
> 

untitled 

You can draw only on the part of the page that's in the drawing 
window. But the entire page is more than three times the size of the 
drawing window, and you can use all of it by moving it behind the 
drawing window to expose the parts that are hidden. "Moving the 
Picture in the Drawing Window" in Chapter 5, "Handling a Picture," 
explains how to go about it. 

Show Page (listed under the Goodies menu in the "Reference" 
section) explains how to see the entire page all at once. Full 
Screen (listed under the same menu) explains how to remove the 
drawing window, menu bar, and the palettes from the screen so you 
can use the entire screen for the picture. 

[ 
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~f At the Easel 
~ 
In this chapter you'll have the opportunity to experiment with the 
basic tools on the easel so that you can discover for yourself how 
simple they are to use. You'll also find out how to correct a mistake 
if you happen to make one. 

The best way to learn how GS Paint works is to paint a picture. The 
subject is a picnic by a pond. 

The Picnic 

Don't feel you need to follow exactly the pictures used as examples 
in the next few chapters. Their purpose is only to demonstrte what 
GS Paint can do. Follow them however much or little you like. 

Note: If you want to stop at any point in this chapter and save the 
picture you've been working on, the beginning of Chapter 3, 
"Saving, Getting, and Printing Your Pictures," explains how to save a 
picture. 
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J Freehand Drawing 

The Pencll. If the pencil isn't selected, move the 
pointer to the pencil icon and click the mouse button to 
select it. 

To draw with the pencil, you move the pointer to the drawing 
window, then hold down the mouse button as you move the mouse. 
The pencil always draws in the color or pattern selected. 

If black isn't selected, select it. Try drawing the rock and the grass 
along the edge of the pond, as shown below. If your first attempt 
doesn't satisfy you, read on - using the eraser is explained next. 

The Eraser. Select the eraser. 

To erase, you hold the mouse button down as you move 
the mouse. Whatever the eraser passes over disappears: 
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The Paintbrush. The paintbrush works much as the 
pencil does. To use it, you hold down the mouse button 
while you move the mouse. The paintbrush always paints 
in the color or pattern selected. 

The next step in the example picture is to use the paintbrush to add 
a shadow by the rock, the outline of a pond, and ripples on the 
pond. 

Select the paintbrush. 

Unlike the pencil, the paintbrush comes in many different shapes. 
The shapes you can choose from are displayed in the Brush Shape 
dialog box. 
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DB 

o. 
o. 

Compress ... 
Show ... 

To display the Brush Shape dialog box, choose Brush Shape from 
the Goodies menu. To do that, position the tip of the pointer 
anywhere on the word Goodies in the menu bar. Hold down the 
mouse button, drag the pointer down until Brush Shape is 
highlighted, then release the mouse button. Brush Shape flickers, 
then the Brush Shape dialog box opens . 

. . / '" .. / " . . / " 

The brush shape with the box around it is the one selected. To 
select a brush shape, you point to it and click the mouse button. 
The Brush Shape dialog box then disappears automatically. 
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For the shadow by the rock, select the smallest round shape. 

· . / , · . / " 
• • / " 

When you've selected it, add the shadow. 

Next you're going to use the brush to paint the edge of the pond, 
but before you do, you need to select a different color. Point to dark 
blue in the palette at the bottom of the screen, and click the mouse 
button. The large square at the left end of the palette changes to 
dark blue to indicate that it's the color you're working with. 

Now paint the edge of the pond. 

Next, change the brush shape to the two-dot diagonal shape . 

• • / , 
• • / " • • / " :.\::~::;':.:' 

• D~' 

Choose light blue from the palette. Paint the ripples around the edge 
of the pond. 
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Undo. Undo cancels the last change you made to a picture. 

To use Undo, you pull down the Edit menu and choose Undo. 

Choose Undo and watch what happens to the picture in the 
drawing window. 

The last ripples you drew have been erased. To put back what Undo 
has just erased, choose Undo from the menu again. 
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Not everything you do can be undone. In general, Undo affects only 
changes you've made to a picture - anything you do using a tool or 
a function on the Edit menu. 

You can't use Undo to reverse a change you've made to a tool 
(usually because it's easy enough for you to reverse the cbange 
yourself). For example, you can't undo the brush shape you've 
selected, although you can undo the last change you made to a 
picture using that brush shape. 

You can't undo anything you do using a command on the File 
menu. For example, it's impossible to "unsave" a picture once 
you've saved it. 

The Spray Can. You use the spray can the same way 
you do the paintbrush and the pencil- you hold down 
the mouse button while you move the mouse. 

The best way to understand how the spray can works is to try this 
experiment: 

Select the spray can and draw a line across the top of the drawing 
window. You'll notice that even though you held the mouse button 
down continuously, the color appears in a "spray." 
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Select the paintbrush and change its shape to the spray pattern. 

• • / " • • / " • • / " []J 
• • ~ 

Draw a second line. 

You'll notice that this time, even though the shape of the brush 
looks just like the shape of the spray can, the results are quite 
different. 

Erase both lines. 

Select the spray can again to add the shading beside the rock. Use it 
first with dark gray, then with light gray. The longer you hold the 
can in one place, the more color it will spray there. 
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The Paint Bucket. You use the paint bucket to fill in 
an area with a color or a pattern. The area you want to 
fill has to be completely enclosed by an outline or 
bordered by areas of other colors (or a combination of 

the two). If there are any gaps around the area, the color or pattern 
you're filling with will "leak" and could fill the entire background. 

If you want to fill an area with two or more colors already in it, you 
have to fill the area occupied by each color separately. 

One color ~-;.!--- An open pattern 

Second color 

Filling a patterned area is different from filling an area that's a solid 
color. Every continuous line in a pattern is a border. You can fill the 

. patterned area only if the pattern is "open" - that is, only if there 
are gaps in the lines that will allow the color you're filling with to 
leak through from one part of the pattern to another. 

To fill an area, you choose the color or pattern you want and select 
the paint bucket. Then you move the paint bucket to the area you 
want to fill and click the mouse button. 

Try filling the rock with light gray. If the color fills the background, 
it means there's a gap in the outline of the rock. Select Undo, find 
the gap and patch it, and try filling the rock again. If only one part of 
the rock fills, the rock is divided into more than one area. Fill the 
other areas as you did the first. 
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Colors and Patterns. Any color or pattern you select is used by 
the pencil, the paintbrush, the spray can, the paint bucket, and all of 
the filled shapes. Only the inside of a filled shape displays the color 
or pattern; the outline of the shape is determined by the line 
selected on the border palette. The color or pattern selected has no 
effect on the appearance· of the straight line or any of the hollow 
shapes. 

Note: You can change the border lines to a color or pattern (see 
"Border Palette" in the "Shortcuts" section). 

The color or pattern you're using paints over all the other colors or 
patterns you've used on the screen before. You can't paint, draw, or 
spray a background behind an image. (You can, however, move an 
image over a background; "The Lasso" in Chapter 5, "Handling a 
Picture," explains how.) 

Try ~dding brown around the edge of the lake. Experiment with 
different brush shapes. 
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Try spraying the rock with different patterns. 

Adding Words 

rr'~'·'·'J.l Text. You can add text anywhere in a picture. ,\~ ,~>jL """~"~, 'I 

r~,;;]I~lX Add a title to the picture. Start by selecting the text icon. 
,\,~, '\\' '" --,,~,/! "', ;n~, 

Notice that when you move the pointer to the drawing 
window, it looks like an I. 
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I Move the I to the corner of the picture and click. Move 
the pointer away and you'll see a blinking vertical line. 
It's called a cursor. It shows you where the next letter 

you type is going to appear. 

Type The Picnic. If you make a mistake, press the delete key to 
erase it. You can also use Undo to erase everything you've typed­
but only if you haven't clicked the mouse button. 

You might end up with something like this: 

You can change the way text looks by changing the font (or 
typeface), the style of the letters, and their size. 

Helvetica 

New York 

New York Bold 
111MI' 'fo Oln~ 

H~ ly~tica 9 point 

Hel vet i ca 24 poi nt 
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You can change text that's already in the picture if you haven't 
pressed the enter key or clicked the mouse button since you typed 
it. Otherwise, you have to erase the text you want to change and 
retype it. 

To change the font, style, or size of the text, choose Choose Font 
from the Font menu. 
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When the Choose Font dialog box appears, you can select the font, 
style, and size you want. 

../ Plain 
Bold 
I talit 
Underline 
Outline 
Shadow 

other: [[] 

To change the style that The Picnic appears in, choose Italic, then 
click the OK button. 

Your picture should look something like this: 
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Saving a Picture 

You can save a picture anytime you want. Saving a picture is 
necessary because the image of the picture on the screen lasts only 
as long as the computer is on. If you turn the computer off without 
saving the picture, you'll lose it. When you save a picture, a copy of 
it is stored on a disk (the original remains on the screen until you 
open another picture or quit). The copy stays on the disk until you 
erase or replace it. Later on, you can have the computer get the 
picture from the disk and redisplay it on the screen. 

To save a picture, first eject the GS Paint disk from the drive and 
replace it with another initialized disk. Or if you have a second disk 
drive, put another initialized disk in it. GS Paint takes up most of the 
space on the program disk, so it's best to save pictures on a different 
disk. (If you need instructions on how to initialize a disk, see your 
Apple IIGS owner's guide.) 

Next, choose Save from the File menu. 
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J A dialog box appears. 

~ / Data Disk / 
Free: 40/800Kb 
....--------...,...if.,-, ( DiSk) 

:: ( New FOlder) 

C:.·::::.·.·.·:::~·~:~i.·~~.~i:::::::.·::.·::) 

~ ( Close ) 

~ Salle . .~ 

( Cancel ) 
@ Paint Format 0 Screen Format 

The dialog box gives you the option of saving a picture in either 
Paint Format (which is preselected) or Screen Format. The 
difference between the two is one of size. The paint format saves the 
entire page a picture is on, while the screen format saves only the 
part of the picture visible in the drawing window. You can save 
more pictures on a disk in screen format than you can in paint 
format. 

In the space under Save As, you type a name for the picture you're 
saving. For the picnic scene, type Picnic. 

You can't undo Save. If you decide not to save a picture, you click 
the Cancel button in the Save dialog box to return to the drawing 
window. 

Click the Save button. 
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When the picture has been saved, the name you've given it appears 
in the title bar at the top of the drawing window. 

Printing a Picture 

To print a picture you choose Print from the File menu. You can 
continue to use GS Paint while a picture is being printed. 

Closing a Picture 

To remove a picture from the easel, you close the drawing window. 
Closing the drawing window doesn't automatically save the picture 
that's there. If you want to keep the picture you have to save it first. 

You close the drawing window simply by choosing Close from the 
FUe menu. If you haven't made changes to the picture since you last 
saved it, the window closes immediately. 

But if you've changed the picture in some way, the process is 
different. 

Make a change to the picture in the drawing window. Choose 
Close. A dialog box appears that asks if you want to save the 
changes you've made. 
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--

Salle changes before closing? 

(( yes) 

( No ) ( Cancel) 

If you click Yes, the Save dialog box appears. 

If you click Cancel, the ~awing window reappears just as it was 
before you chose Close. 

Click No, since you don't want this version of the picture. The 
drawing window disappears from the easel, and the picture isn't 
saved. 

Opening a Picture 

To get back from a disk a picture you've saved, you open the 
picture. 

Choose Open from the Flle menu. A dialog box appears. 
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Load File: 

~ / Data Disk / 

On the left half of the screen is a list of the names of the pictures 
and other files on the disk. The list is called a catalog. If the catalog 
has more names listed on it than can fit in the window, you can 
scroll the list up and down to see all the names. 

Choose Picnic from the list and click Open. The picture reappears 
on the easel. 
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Drawing Straight Lines 

The Straight Line. Drawing a straight line with the 
pencil is a challenge. But you can draw straight lines 
easily with the straight line tool. 

Click the straight line icon. When you move the pointer to the 
drawing window, it takes the shape of cross hairs. 

Use the straight line to draw the horizon and the blanket, as shown 
below. Position the pointer where the horizon starts, then hold 
down the mouse button. The straight line works something like a 
rubber band. It stretches and contracts as you move the pointer 
away from or toward the starting point. You'll notice the line is 
unaffected by the color or pattern selected; the color and width of 
the line is determined by the border palette. 

The Picnic 

When you have the line positioned where you want it, release the 
mouse button. If you don't like the placement of the line, use Undo 
to erase it. 
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Use straight lines to draw the blanket, then fill it with the pattern 
that appears in the illustration. Fill the pattern with any color you 
want. 

Drawing Shapes 

GS Paint has special tools for drawing rectangles, rounded rectanges, 
ovals, free-form shapes, and polygons, all either hollow or filled. 

Hollow Shapes. A hollow shape is just an outline. 
Whatever is behind the shape shows through the area 
inside the outline. 

Filled Shapes. A filled shape is an outline filled with a 
color or pattern. The part of the picture behind the 
shape doesn't show through. 
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Remember that the color of outlines of both filled and hollow 
shapes is determined by the border palette, not the color or pattern 
selected. 

Rectangles and Rounded Rectangles. 
Rectangles and rounded rectangles (both 
hollow and filled) work the same way. 

Select the hollow rectangle. Position the center of the cross hairs 
where the upper left comer of the picnic basket is in the picture. 

The Picnic 
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When you have the pointer positioned, hold down the mouse 
button and drag the mouse toward the lower right. A rectangle 
appears that expands and contracts as you move the pointer. When 
it looks like it's about the right size, release the mouse button. The 
rectangle remains on the screen. 

Because you've used the hollow rectangle, the blanket shows 
through the rectangle. You could erase everything on the inside of 
the rectangle, but an easier way to solve the problem is to use a 
filled shape. 

First select Undo to erase the hollow rectangle. Then select the 
filled rounded rectangle, and pick the wicker pattern from the 
palette. Once again position the cross hairs where the upper left 
corner of the picnic basket is. Hold down the mouse button and 
move the mouse. This time a rectangle with rounded corners 
appears. When it IOQks like it's about the right size, release the 
mouse button. Immediately, the rounded rectangle is filled with the 
wicker pattern. 

You'll notice the wicker pattern isn't transparent - the color of the 
blanket doesn't show through the white spaces in the pattern. None 
of the other patterns is transparent either. But you can make a 
pattern look transparent by filling the white spaces with the color of 
the background (see "Changing Patterns" in Chapter 6, "Advanced 
Techniques"). 
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Ovals. Drawing an oval is similar to drawing a 
rectangle. The major difference is that it takes a 
bit more practice to position an oval accurately. 

Try this experiment: 

Select the hollow oval. The pointer again becomes a set of cross 
hairs. Position the cross hairs anywhere in the drawing window. 
Hold down the mouse button and drag the mouse. The outline of an 
oval appears, stretching and contracting as you move the mouse. 

You'll notice that the upper left edge of the oval doesn't stay in one 
place as the upper left corner of a rectangle does. That's because the 
position of the oval is determined by an invisible rectangle that 
would look like the illustration above if you could see it. 

The upper left corner of the invisible rectangle does remain in the 
same place, but as the rectangle gets bigger, the upper left edge of 
the oval moves away from the upper left corner of the rectangle. 

With that in mind, first undo the experimental oval, then try to draw 
the plate that's on the blanket in the following picture. Select the 
filled oval, and choose white from the palette. Position the cross 
hairs for the outside edge of the plate, then drag. If you don't like 
the result, undo it. When you're satisfied with the outside edge, 
draw the inner rim. 
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The Picnic 

When you've finished the plate, use the oval to draw an orange. 
Then use the oval to draw the lily pads using light and dark green. 

o 

o 

The wine goblet is made of three ovals. Select white 
again, then draw a narrow oval. 

Next, draw a second oval even with the top of the first. 

Draw a third oval about the same size for the base. 

Finally, select the double-width line from the 
border palette and join the cup to the base 
using the straight line tool. 
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~~ ... Free-form Shapes. With the free-form shape 
you can draw a figure with any imaginable 
outline. The only constraint that the free-form 
shape puts on what you draw is that it must be 

closed. If you don't close the figure, a straight line is drawn 
automatically between the two loose ends of the outline. 

The free-form shape works like the pencil or paintbrush. After 
you've selected the free-form shape, you position the pointer where 
you want to begin drawing. Then you hold down the mouse button 
and draw the outline you want. When you've completed it, you 
release the mouse button. 

Use the free-form shape to draw the napkin that's draped over the 
side of the picnic basket, as shown in the drawing below. First select 
the single-width line from the border palette. Then choose the filled 
free-form shape and a pattern that appeals to you. Position the cross 
hairs and start drawing. When you release the mouse button, the 
shape is filled in with the pattern you've chosen. If you don't like the 
result, undo it and try again. 

The Picnic 
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Polygons. A polygon is an irregularly shaped, 
closed figure made up entirely of straight lines. 
Like the free-form shapes, any polygon that you 
draw closes itself automatically if you don't 

connect the end point with the beginning. 

Using the polygon drawing tool is like using an endless supply of 
straight lines. After you've selected it, you position the cross hairs 
where you want the figure to start. You then click the mouse button 
to anchor one end of the first line. The line stretches and contracts 
as you move the mouse. When you have the line positioned where 
you want it, you click the mouse button again to anchor the other 
end of the line; at the same time you anchor one end of the second 
line. You repeat the process until you've completed the figure you 
want. Then double-click the mouse button or click anywhere 
outside the drawing window. If the beginning of the first line and 
the end of the last one don't meet, a line is drawnautomaticaUy to 
connect the two. 

To see how versatile the polygon is, use it to draw the snowcaps on 
the mountains. Select the hollow polygon and position the cross 
hairs where you'd like to begin. Continue drawing lines until you've 
arrived back where you started. Then double-click the mouse 
button. 
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Finish the picture by filling in the areas that are blank with colors or 
patterns that appeal to you. Before you add something you're not 
sure about, you might want to save the picture first in case you 
don't like the results. You can also save different versions of the 
picture under different names. See "Save As" in the "Reference" 
section for instructions. 





/ Chapter 5 

~ Handling a Picture 
~ 
It's much easier to compose a picture if you can move parts of it 
around, make copies of images that you want to use more than once, 
change the shape or orientation of an image, and so on. You can do 
all those things with GS Paint, but only if you've first selected the 
part of the picture you want to work with. There are two tools you 
can use to select images already in the drawing window - the 
marker box and the lasso. 

Selecting an Area 

The Marker Box lets you select a rectangular area of 
a picture and then cut it, copy it, move it, change its 
orientation, save it, move it from one picture to another, 
or stretch or shrink it. 

You position a marker box the same way you position a rectangle: 
you move the cross hairs to the upper left corner of the area you 
want to mark. You then hold down the mouse button and drag the 
box down and to the right until it outlines the entire area you want 
to select. When you release the mouse button, the dotted outline of 
the box appears to "race" around the selected area to let you know 
it's the active part of the screen. The area will remain selected until 
you click the mouse button somewhere outside the selected area. 

In the next experiment, you'll first select an image with the marker 
box, then use the marker box to move the image around the 
picture. 
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Open the picture named Teacup (the Open command is on the 
File menu). If the name doesn't appear on the part of the catalog in 
the window, scroll the catalog up until Teacup appears. 

When the picture appears, select the marker box from the tool 
palette. Position the cross hairs a little above and a little to the left 
of the top teacup, as shown below. 

Drag the mouse until the box surrounds the teacup. Release the 
mouse button. The teacup is now selected. 

Moving a Selected Area 

You can move the area you've selected by positioning the pointer 
inside the selected area, then dragging it. 

Move the pointer inside the selected area. It changes from the cross 
hairs to the arrow. Hold down the mouse button and move the 
pointer slowly. The box and everything in it moves with the pointer. 

Move the teacup to a new position and release the mouse button. 
The teacup remains selected, and you can adjust its position until 
you've placed it exactly where you want it. When you're satisfied, 
click the mouse button. The marker box disappears. 
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Using the Lasso 

The Lasso has two features that distinguish it from the 
marker box. First, the lasso can take any shape you want 
it to - you're not limited to selecting a rectangular area 
with it. You can use the lasso to select a part of an 

image, like the one shown in the picture below, that would be 
impossible to select with the marker box. 

The lasso works in much the same way as the free-form shapes do: 
you draw a line with it by holding down the mouse button while 
you move the pointer, and when you release the mouse button, the 
beginning and end of the line are automatically connected. 

This experiment will help you understand how the lasso is different 
from the marker box: 

First use the marker box to select the handle of the cup in the lower 
half of the picture. When you've selected it, move it with the 
pointer and try to attach it to the teacup. You'll notice it doesn't 
work. The marker box moves not only the handle, but the 
background around it, too. Choose Undo to return the handle to 
where it was. 

Select the lasso and use it to draw a line around the handle, as 
shown in the following illustration. When you release the mouse 
button, the dotted outline that appears follows not the outline that 
you drew, but the outline of the handle. 
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Move the tip of the lasso inside the outline. When the lasso changes 
to the arrow, hold down the mouse button and drag the handle to 
the teacup. Because the lasso has selected only the handle itself, you 
can position the handle so it touches the teacup without erasing any 
part of it. Release the button. The handle remains selected if you 
need to adjust its position. When you have the handle positioned as 
you want it, click anywhere outside the outline and the handle is 
permanently attached to the teacup. 

The second difference between the lasso and the marker box is that 
you can use the lasso to lift an image off the background. 

"Background" has a special meaning. It means only the true 
background color - not just any color that happens to be in the 
background behind an image. The true background color is the 
color surrounding the box on the palette where the selected color 
or pattern appears. 

~ · . · '- · . 

". True background color 
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This experiment will help you understand: 

Open the picture named Shapes. 

When it appears, use the marker box to select the circle. Then move 
the circle to the left half of the screen. You'll notice that the 
selected area contains the background color as well as the circle. 

Use Undo, then use the lasso to select the circle. Move the circle to 
the left half of the screen again. This time you can move the circle 
without the background. Use Undo again to move the circle back to 
its original position. 

Use the lasso to draw an outline around the triangle. This time the 
outline that appears marks the exact area the lasso traced - not just 
the triangle itself. 

Now move the triangle. The color behind the triangle moves along 
with it, revealing the true background color. Use Undo again. 

For the next part of the experiment, you need to change the 
background color. To do so, point to dark green on the color 
palette, hold down the option key, and click. The background behind 
the selected color square changes to dark green to indicate that it's 
now the true background color. 

Use the lasso to select the triangle. Because dark green is now the 
true background color, this time the dotted outline matches the 
outline of the triangle exactly. Move the triangle to the right half of 
the screen. You can do so without moving the background color 
along with it. Use Undo to return the triangle to its original 
position. 
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Next, use the lasso to select the circle. White is no longer the true 
background color, so the outline that appears marks the exact .area 
the lasso traced - not just the circle. 

Now move the circle. The color behind the circle moves along with 
it, revealing the true background color. 

Try the same experiment using a free-form shape and other 
background colors. See what happens when an image straddles the 
boundary between the background color and a large area filled with 
color. 

When you're finished, change the true background color back to 
white. 

Copying an Image 

You can make a copy of anything you select with either the lasso or 
the marker box. 

Open the picture named Pumpkin. When the picture appears, use 
either the lasso or the marker box to select the pumpkin. 

To make a copy of the pumpkin, choose Copy from the Edit menu. 
Copy flickers and then the Edit menu closes. A copy of the 
pumpkin has been made on the Clipboard. The Clipboard is a 
separate page that's always available to hold images you cut out or 
copy. The copy of the pumpkin stays there until you copy or cut out 
something else. 
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To add a copy of the pumpkin to your picture, choose Paste from 
the Edit menu. Paste flickers, and then a copy of the pumpkin 
appears in the center of the screen. The copy is automatically 
selected; you can move it by positioning the pointer inside the 
selected area, holding down the mouse button, and dragging the 
pumpkin to wherever you want to place it. When you have it 
positioned, click the mouse button anywhere outside the selected 
area to paste the copy in its new location. 

For another copy repeat the same process. 

You can also make a copy of a selected object by holding down the 
command key while you move the object. Paste the copy in a new 
location by positioning it, then clicking the mouse button anywhere 
outside the selected area. 

Inverting a Selected Area 

You can select an area of a picture with the marker box and then 
invert it, which changes every color to its palette complement. A 
color's palette complement is different from its true complementary 
color because it's determined entirely by the color's position in the 
palette and the other colors in the palette. The complement of, say, 
the fourth color from the left end of the palette is the fourth color 
from the right end of the palette: 

I-I I! I~! I ! I I I ! I !~I ! I I 
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The complement of the third color from the left end is the third 
color from the right end, and so on. 

To invert an image, first select it with the marker box (you can't use 
the lasso for this procedure). Choose Invert from the Edit menu. 
Try this with the pumpkin and watch what happens. 

Flipping a Selected Area Horizontally 

You can change a part of a picture to its mirror image by selecting 
it, then flipping it horizontally. 

Open the picture named Hand. 

When the picture appears, select the hand with the marker box 
(you can't use the lasso for this procedure). Try to make the marker 
box fit the object as closely as possible. Choose Flip Horiz. from 
the Edit menu. After a moment, the hand's mirror image appears. If 
you fitted the marker box to the object carefully, the hand will not 
be repositioned in the picture, just reoriented. 

Flipping a Selected Area Vertically 

You can also flip a selected area from top to bottom. 

Select the hand with the marker box if it isn't still selected (again, 
you can't use the lasso for this procedure). Try to make the marker 
box fit as snugly as possible. Choose Flip Vert. from the Edit 
menu. 
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After the selected area has been flipped,everything that was on the 
right side of the marker box is still on the right, and everything that 
was on the left is still on the left. But everything that was on top is 
now on the bottom, and vice versa. And once again, if the fit· was 
snug, the hand has been reoriented without being repositioned. 

Rotating a Selected Area 

In addition to flipping images horizontally and vertically, you can 
select an area and rotate it a quarter turn counterclockwise. 

Select the hand with the marker box again, if necessary (you can't 
use the lasso with Rotate). Since the entire area inside the marker 
box will be rotated,if the hand is off-center in the marker box, it 
will be off-center after it's rotated. Choose Rotate from the Edit 
menu. 

Any object, after it's been rotated, will appear to be distorted. That's 
because the pixels - the tiny dots of color that make up an image 
on the screen - aren't square, but rectangular; they're taller than 
they are wide. 

Stretching a Selected Area 

It's possible to change the shape of an object by stretching or 
compressing it. You can make an object narrower or wider, or taller 
or shorter. You cannot, however, stretch or compress an object 
along a diagonal. 



Handling a Picture 

Select the hand with the marker box, if necessary (the lasso doesn't 
work for this procedure); To stretch the hand, position the pointer 
on the bottom edge of the marker box, hold down the command 
key, and drag the bottom edge of the marker box down. The bottom 
edge of the marker box moves down with the pointer, but the 
upper edge stays anchored in place. 

You can also stretch the hand by dragging the right edge right, the 
left edge left, or the top edge up. To shrink the hand, drag the 
bottom edge up, the right edge left, the left edge right, or the top 
edge down. You can also stretch or shrink the hand in two 
directions at once by dragging one of the comers of the marker box. 

Moving the Picture in the Drawing Window 

The drawing window shows less than a third of the space that's 
available on the page. You can move the page around in the window 
with the hand icon. 

Select the hand icon. When you move the pointer to the 
drawing window, it takes the shape of a hand. Position 
the hand near the bottom of the window. Hold down the 
mouse button and move the pointer up, and the page 
moves with it. 

Keep moving the page up until a picture of another hand appears at 
the bottom of the drawing window. Notice that this is a different 
hand (the sleeve is blue, not gray) - you haven't looped back to the 
top of the page. Rather, you've exposed a part of the page that 
wasn't visible before. 
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Moving to Another Part of the Page 

There are two ways to move to another part of the page. One is to 
keep moving the page with the hand until a part of the page that 
was completely hidden before appears in the window. The other 
way is to use the Show Page command. 

Choose Show Page from the Goodies menu. The screen changes 
to show a reduced representation of the entire page. 
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The dotted rectangle represents the drawing window, indicating 
which part of the page is now visible in the drawing window. 

To move to another part of the page, drag the dotted rectangle 
there. Click OK, and when the drawing window reappears, the new 
part of the page is visible in it. 
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Moving an Image to Another Part of the Page 

You can also move an image to another part of the page using the 
Show Page command. 

Once again, choose Show Page from the Goodies menu. The 
reduced representation of the entire page appears. When you place 
the pointer outside the dotted rectangle, it works like the hand. 
Hold down the mouse button and push the page around until the 
image is where you want it. But be careful- if you push any part of 
the picture off the page it will be erased. When the image is 
positioned where you want it, click OK, and the drawing window 
reappears with the page repositioned in it. 

Cutting and Pasting a Selected Area 

You can also move an image from one part of the page to another 
by cutting and pasting it. 

Use either the marker box or the lasso to select an image in the 
drawing window. Then choose Cut from the Edit menu. Cut 
flickers and then the selected image disappears. A copy of it has 
been placed on the Clipboard. 

Move to another part of the page using either the hand or the Show 
Page command. Then choose Paste from the Edit- menu. The 
image you cut before reappears. It's automatically selected, so you 
can position it before you paste it to the page. A copy of the image 
remains on the Clipboard until you cut or copy something else. You 
can paste as many copies of the image in the picture as you want. 
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Moving an Image to Another Picture 

You can move an image not only from one part of a picture to 
another but also from one picture to an entirely different picture. 

You start by cutting or copying the image you want to move: you 
select it with either the marker box or the lasso, and then choose 
either Cut or Copy from the Edit menp. Then you close the 
picture you've cut or copied the image from and open the picture 
you want to move it to. Finally, you move to the part of the new 
picture where you want to paste the image and choose Paste from 
the Edit menu. The image appears in the new picture. 

Try it yourself: 

First, use the marker box to select the image of the hand. Select 
Copy from the Edit menu. Copy flickers and then the Edit menu 
closes. A copy of the hand has been made on the Clipboard. 

Next, choose New from the File menu. When the dialog box 
appears, asking if you want to save the changes you've made, click 
No. A clean page appears. 

Choose Paste from the Edit menu. The image of the hand appears. 
It's automatically selected, so you can place it wherever you want 
on the page. When you have it positioned, move the pointer outside 
the selected area and click the mouse button. The hand is pasted to 
the page. 
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Moving an Image to a GS Write 
Document 

You can use GS Paint to create illustrations for documents you've 
written using GS Write. You can paste such illustrations right into the 
document itself 

The process works like this: 

First, you create and save an illustration. Next, you use the marker 
box or lasso to select the illustration and Copy to make a copy of it 
on the Clipboard. There must be a copy of the illustration on the 
Clipboard for you to paste it into a text document. 

The next step is especially important. You use Quit to leave GS 
Paint. Don't reset the computer or tum it off. If you do, the copy of 
your illustration on the Clipboard will be lost. A moment after you 
use Quit, the launcher appears on the screen. 

Next, you eject the GS Paint program disk from the drive and replace 
it with the GS Write disk Then you click the Disk button. 

When the list of the files on the GS Write disk appears in the 
window on the launcher, you select Writer. When the document 
window appears, you choose Open from the GS Write File menu and 
open the document you want the illustration to appear in. 

You then go to the place in the document where you want the 
illustration to appear and move the cursor to the exact line where 
you want the illustration to be inserted. Finally, you select Paste 
from the Edit menu. The text at the spot where you positioned the 
cursor moves down, and the illustration appears in the document at 
that point. 



,,/ Chapter 6 

~ Advanced Techniques 
~ 
Toolsfor Modeling 

In the graphic arts, modeling is the process of giving a two­
dimensional object the appearance of depth through the use of light 
and shadow. In the illustration below, the only thing that tells your 
eye that one of the figures is a circle and the other is a sphere is the 
shadowing in the figure on the right. 

The tools you'll find easiest to use for modeling are the paint bucket 
and the spray can. 

Modeling with the Paint Bucket 

When you want to model a rectilinear figure - one with straight 
edges and flat surfaces - you can use the paint bucket to fill the 
surfaces with different colors or different patterns. 

To try this, first open the picture named Cubes. When the picture 
appears, make several copies of the cubes so you'll have plenty of 
examples to work with. 
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Using Patterns. Next, decide on three patterns, one mostly white, 
one mostly black, and the third somewhere in the middle. Fill the 
front surface of one of the cubes with the lightest pattern, the side 
with the darkest pattern, and the top with the in-between pattern. 

LJJ •. ::mmmlllmr: .......... . . ......... . .......... ........... .......... ........... .......... 
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Here are some oth~r experiments you can try: 

Move the patterns to different sides of the cube to see if you can 
make it look like the light is coming from a different direction. 

Add a shadow on the side of the cube opposite the direction the 
light is coming from. 

Try different types of patterns and different combinations of patterns 
to see which give the most convincing effects. 

Using Color. Decide on three related colors (for example, light 
blue, blue-gray, and dark blue; or white, gray, and black). Fill the 
front surface of a cube with one, the top with another, and the side 
with the third. Try different combinations. Try filling a pattern with 
a color. 



Advanced Techniques 

Modeling with the Spray Can 

The spray can works best for modeling non-rectilinear figures­
those that don't have straight edges and flat surfaces. The spray can 
lets you blend light and shadow much more subtly than the paint 
bucket does. 

Draw a circle and model.it with the spray can. Experiment with 
colors and patterns to see which give the best results. You'll notice 
as you use the spray can near the edge of a circle that flecks of color 
often appear on the background outside the circle. The next section, 
"Drawing in Detail," explains an easy way to erase them. 

Drawing in Detail 

The small dots of color distributed by the spray can are called 
pixels. A pixel is the smallest amount of color you can put on the 
page - and ultimately, everything you draw or paint can be broken 
down into pixels. Any line you draw with the pencil is made up of 
pixels lined up end to end. When you use the paint bucket to fill an 
area, you're filling the area full of pixels. As small as pixels are, you'll 
sometimes want to draw or erase them one at a time. 
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You can use FatBits from the Goodies menu to enlarge the pixels 
(or "bits" of color) in the picture you're working dn so they're 
easier to work with. 

Say, for example, you were modeling a sphere, and your picture 
now looked like this. 

Choose FatBits from the Goodies menu, and the upper right edge 
of the drawing would look like this: 

I. • • •• • • • : .. : .. • • • • : :.:.... .1 
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You can use either the eraser or the pencil to· remove pixels. The 
pencil is a little more precise than the eraser. If you decide to use 
the pencil, make sure you haven't changed the color you've been 
using. Select the pencil, move the pencil to a pixel, click, and the 
pixel disappears. 

• • •• • •• • •••• 
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You can use any of the tools in the palette when you're working in 
fat bits. Experiment with them to see how they work. To return to 
the normal view of your picture, choose FatBits again. 

Changing Patterns 

You can change any· of the patterns in the palette, and you can also 
add color to any of them. 
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Start by selecting the pattern you want to change. Then choose 
Edit Pattern from the Goodies menu. This dialog "box appears: 

J W ki W' d or ng tn ow 

J , 
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( OK ) ~ ( Cancel) 

The window on the left is the working window - where you make 
changes to the pattern; the window to the right of it shows you 
what the pattern will look like in the picture, Below the windows is 
a color palette. You choose a color from it just like you do from the 
main palette. 

Use the pointer just as you use the pencil when you're working in 
fat bits: if you position the pOinter on a pixel and click, the pixel 
disappears; if you move the pointer to an empty spot or to a place 
where there's a pixel of a different color and click, a pixel of the 
selected color appears. You can also draw with the pointer by 
dragging it. 

When you finish making changes, click the OK button. If you decide 
you don't want to keep the changes you've made, click Cancel 
instead. 
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Choosing Colors for the Palette 

The color palette contains 16 colors for you to use. If you want to 
use colors different from the ones currently in the palette, you can 
choose others from the 4096 colors that GS Paint can produce. 

To choose a new color, choose Color Palette from the Color 
menu. 
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The Color Palette Dialog Box 

The dialog box shown below appears. 

( OK ) I 
(cancel) 

1011111111111111111 
Red Mixer 'iJ 'iJ 'iJ 'iJ 'iJ Working 

Red 
Color 

Bar 

Slider 

Mixer Color Bar ' Mixer Mixer 

Color 

Spectrum 
Palette 

The five vertical bars of color in the lower half of the screen are the 
color mixers. 

In the group of three on the left, each controls one of the primary 
colors. The one on the left is for red, the one in the middle for 
green, and the one on the right for blue. Notice that next to each of 
them is a color bar that shows the range of the intensities available, 
from brightest to black. 

The two mixers on the right side of the dialog box control the 
shade-the lightness or darkness-of a color. The mixer on the left 
makes the color lighter, the one on the right makes it darker. 

The working color reflects the positions of the sliders on the mixers. 
Every change in the pOSition of the sliders produces a different 
color. 
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You can move the sliders up and down to change the amount of red, 
green, and blue in the working color or to lighten or darken it. 

The spectrum palette in the lower right corner displays the basic 
spectrum of colors: the primary, secondary, and neutral colors 
(brown, gray, white, and black). 

The palette that divides the screen in half is a copy of the one on 
the easel. 

Finding a Color 

The easiest way to scan the colors available to find the one you 
want is to do this: 

First, position the pointer on the color in the spectrum palette that's 
closest to the color you want (for example, if you want khaki, 
position the pointer on brown). Hold down the mouse button. A 
dotted outline appears around the color. Drag the dotted outline to 
the working-color box and release the mouse button. The color in 
the box changes to the color you've selected from the spectrum 
palette, and the sliders on the mixers move automatically to their 
positions for that color. 

Each of the mixers shows 16 different variations on the color you've 
selected. For example, the green mixer shows 16 variations with 
more or less green mixed in. The lightness and darkness mixers 
show variations with more or less white mixed in. 

If you don't see the color you want, pOSition the pointer on the 
variation closest to it and drag the variation to the working-color 
box. When you release the mouse button, a different set of 
variations appears. 
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If you want to see what a color looks like on your picture, move the 
pointer to the window in the upper half of the screen. The pointer 

,turns into a paintbrush, and you can draw on the picture there with 
perfect safety - whatever you draw will be automatically undone 
when you return to the drawing window; 

Adding a New Color to the Palette 

When you've found the color you want, position the pointer on it 
and hold down the mouse button. Drag the dotted outline to the 
palette in the middle of the screen and replace one of the colors 
there with the new color. Everywhere you used the old color in the 
picture, it will be replaced by the new color. If you don't want any 
of the colors you used in the picture to be replaced, replace a color 
you haven't used in the picture. 

There are two changes to be wary of: changing the colors at the two 
ends of the palette - the colors preset to black and white. If you 
replace white with another color, that color instantly replaces white 
as the background color of the easel. Don't replace white with black 
or the screen will become unreadable. Something similar will 
happen if you replace black with another color: that color instantly 
replaces black as the text and outline color of the easel. Don't 
replace black with white. If you happen to replace either color with 
a color that makes the screen unreadable; press the esc key to undo 
the change. 

When you've made all the changes to the palette you want to make, 
click OK to go back to the drawing window. If you want to return 
to the drawing window without keeping any of the changes you've 
made, click Cancel 

The new palette is saved when you save the picture you're working 
on. You can also save the palette separately in the Palette Table (see 
"Palette Table" under the Color menu in the "Reference" section). 
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Mixing a Color 

If you'd like to mix a new color yourself, you can do that, too. 
Mixing colors is mostly a matter of experimenting until you get the 
mix you want, but it may help you to understand how the process 
works. 

When you mix colors using GS Paint, you're actually mixing light of 
different colors. Mixing light is different from mixing paint. The major 
difference is that if you mix all the colors of paint together, the result 
is black; when you mix all the colors of light together, the result is 
white. 

As the color chart below shows, the three primary colors of light are 
red, green, and blue. Mixing red and blue produces magenta, mixing 
blue and green produces cyan, and mixing green and red produces 
yellow. Mixing all three together produces white. 

To mix a color, move the sliders on the three color mixers up and 
down. You can move a slider either by clicking the arrows or by 
dragging the slider with the pointer. 
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The mixers work like dimmers: if you move the slider to the 
bottom, you turn the color up as far as it can go; if you move the 
slider to the top, you turn the color off. 

Experiments 

Try these experiments: 

Turn up all the color mixers to their highest levels. The result is 
white. White light is made up of all the colors of the spectrum - all 
of which can be derived from the three primary colors, red, green, 
and blue. 

Turn up the red and green mixers all the way, and turn the blue 
mixer off. The result is yellow. 

Turn the red, green, and blue mixers off. The result is black. Black is 
the absence of any light. 

Don't confuse the brightness of a color with lightness. The brightest 
red is the reddest, most intense red. The lightest red is a little red 
mixed with a lot of white - in other words, a pale pink. 

Turn the red mixer up all the way, and turn both the green and the 
blue mixers off. The result is the most intense red. The slider on the 
lightness mixer is at the very top, and the slider on the darkness 
mixer at the very bottom. That's always the position they have when 
a color is most intense. Now move the sliders on the green and blue 
mixers up one notch each. The result is still red, but it's a slightly 
lighter red. You'll also notice that the slider on the lightness mixer 
moved down a notch. Keep moving the green and blue mixers up a 
notch at a time to see what happens. 
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You can, of course, make a color lighter by moving the slider on the 
lightness mixer or darker by moving the one on the darkness mixer. 
And when you do, the sliders on the color mixers move in response. 
Of all the aspects of GS Paint, the color palette offers the most 
possibilities for experimentation. Remember, too, that you can mix 
color with black and white patterns and create new patterns using 
any (or all) of the 16 colors in the palette. 

Animation 

Animation involves two types of changes: moving an object around 
the screen and changing the color of an object. For example, you 
could create a sunrise by first changing the sky from black to dark 

. blue to purple to rose to red-orange and then having the sun rise 
above the horizon. 

The first step in developing an animation sequence is to draw the 
individual pictures that make up the sequence. Each of the pictures is 
saved separately. Your GS Paint disk contains a series of pictures that 
shows stages in the bouncing of a ball. 
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Open BallOlO to see the first picture in the series. The other 
pictures are numbered Bal1020, BaIl030, and so on. Whenever 
you create a series of pictures you intend to animate, give each of 
the pictures the same name followed by a number that shows the 
picture's place in the animation sequence. It's best to use a series of 
numbers like 010, 020, 030, and so on, so if you decide you want to 
add more pictures in the middle of the series you don't have to 
renumber all of them. 

When you've finished drawing and saving each of the pictures in a 
series, you close the drawing window. 

Close the picture that's now on the easel. Choose Compress from 
the Goodies menu. A dialog box appears. 

Select one of your images: 

§ I Data Disk I 

~ 
'--

~ 

( 

( 
( 
( 

Disk ) 

Open j 
Close ) 
Cancel ) 

You choose from the Compress dialog box any of the pictures in the 
series you want to animate. To compress the bouncing ball 
sequence, choose BallOlO and click the Open button. 
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GS Paint animates the series. Then a second dialog box opens to let 
you adjust the timing of the animation. 

Timing: 2 

Move the box to the right to slow the animation down. You cah 
move the box either by dragging it or by clicking the arrows at 
either end of the speed bar. The number above the speed bar shows 
how many thirtieths of a second separate each picture from the 
next. For example, 

2 = 2/30ths (or 1/15th) ofa second = 15 pictures/second 

6 = 6/30ths (or 1/5th) ofa second = 5 pictures/second 

30 = 30/30ths or 1 second 1 picture/second 
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Another dialog box, like the one that accompanies the Save 
command, appears. GS Paint has named the animated sequence 

. Ball.show. To save the sequence click Save. GS Paint saves the 
compressed sequence of pictures along with the speed setting. 

To run the sequence, choose Show from the Goodies menu. 
Choose Ball.show from the dialog box that appears, and click 
Open The animated sequence runs; when it reaches the end, it 
starts over again. The sequence continues to repeat until you click 
th.eJnouse button. 

If you want to change the timing of the animation, choose 
Compress and repeat the process. 



The shortcuts introduced in this section are especially helpful 
once you've become familiar with GS Paint and feel 
comfortable with it. They're explained as briefly as possible 
without illustrations or examples. 

The shortcuts fall into two groups: alternatives and guides. 

Alternatives give you a second, quicker way to do something you 
already know how to do. For example, you can erase the entire 
drawing window by double-clicking the eraser icon. 

Guides as GS Paint's version of drawing tools like the T-square, 
compass, protractor, and straight edge. They help you to draw figures 
like straight lines and perfect circles that are almost impossible to do 
freehand. They also help you to move and align images with 
precision. For example, if you want to draw a straight line at a 45-
degree angle, you can hold down the shift key to guide the straight 
line tool along one of thre~ paths: horizontal, vertical, and 45-degree 
diagonal. Or if you're moving a selected image with the pointer, you 
can hold down the shift key to guide the movement along an exact 
horizontal or vertical line. 

The shortcuts are presented first for the tools, then for the palettes, 
and finally for the menus. 
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Lasso 

• To keep a selected image on a straight horizontal or 
vertical line while you move it, hold down the sblft 
key. 

Marker Box 

• To select the entire window, double-click the marker 
box. 

• To keep a selected image on a straight horizontal 
orvertical line while you move it, hold down the sblft 
key. 

• To stretch or shrink an image, select the image with 
the marker box, position the pointer along an edge or 
corner of the box, hold down the command key, and 
drag. Drag toward the the center of the image to shrink 
it, away from the image to stretch it. 

Hand 

• To change the pencil to the hand, hold down the 
option key. 

• To keep the hand on a straight horizontal or vertical 
line while you move it, hold down the shift key. 

Text 

• To display the Font, Style, and Size dialog box, double­
click the text icon. 
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Paintbrush 

• To display the Brush Sizes dialog box, double-click the 
paintbrush icon. 

• To draw a straight horizontal or vertical line with the 
paintbrush, hold down the shift key while you draw. 

Pencil 

• To switch to fat bits, double-click the pencil icon. 

• To draw a straight horizontal or vertical line, hold 
down the shift key while you draw. 

• To change the pencil to the hand, hold down the 
option key. 

• To keep the pencil at the same point on the page when 
you switch between fat bits and the normal view of the 
screen, hold down the command key and dick. 

Eraser 

• To erase the entire drawing window, double-click the 
eraser icon. 

• To erase in a straight horizontal or vertical line, hold 
down the shift key while you erase. 

Straight Line 

• To draw a horizontal, vertical, or 45-degree line, hold 
down the shift key. 
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Rectangles (Hollow or Filled) 

• To draw a square rather than a rectangle, hold 
down the shift key. 

Rounded Rectangles (Hollow or Filled) 

• To draw a rounded square rather than a 
rounded rectangle, hold down the shift key. 

Ovals (Hollow or Filled) 

• To draw a circle rather than an oval, hold 
down the shift key. 

Polygons (Hollow or Filled) 

• To draw a polygon with lines that are 
horizontal, vertical, or 45-degree diagonal 
only, hold down the shift key. 

Border Palette 

• To change the border to a color or pattern, hold down the 
command key while you select the color or pattern you want. 
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Color/Pattern Palette 

• To change the background color, hold down the option key and 
select the color you want. 

• To display the Color Palette dialog box, double-click any color in 
the palette. 

• To transfer any color in the Color Palette dialog box (any color in 
the mixers, any color in the color bars, or any color in the 
spectrum palette in the lower right corner of the screen) to the 
palette, click and drag it there. 

• To display the Edit Pattern dialog box, double-click the pattern 
you want to change. 

Menus 

File 

Dialog Boxes 

• Press the return key or enter key to carry out the function you've 
selected. 

• Press the esc key to cancel the function you've selected. 

New 

• Hold down the command key and type N 

Open 

• Hold down the command key and type 0. 
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Close 

• Click the dose box, which is at the left end of the title bar above 
the drawing window. 

Save 

• Hold down the command key and type S. 

Print 

• Hold down the command key and type P. 

Quit 

• Hold down the command key and type Q. 

Edit 

Undo 

• Hold down the command key and type Z. 

• Press the esc key. 

Cut 

• Select part of the picture, hold down the command key, and type 
X 

Copy 

Select part of the picture, then: 

• Hold down the command key and type C. 

• Hold down the command key, move the pointer to the area 
selected, and click. 
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Paste 

• Hold down the command key and type V. 

Clear 

• Select part of the picture, then press the delete key. 

Goodies 

FatBits 

• To change to fat bits, double-click the pencil icon. 

• To keep the pencil at the same point in the picture when you 
switch between fat bits and the normal view of the picture, hold 
down the command key and click. 

Show Page 

• To display the entire page, double-click the hand icon. 

• To keep the dotted rectangle on a horizontal or vertical line when 
you move it, hold down the shift key. 

Brush Shape 

• To display the Brush Shape dialog box, double-click the paintbrush 
icon. 

Edit Pattern 

• To display the Edit Pattern dialog box, double-click the pattern 
you want to edit. 
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Color 

Color Palette 

• To display the Color Palette dialog box, double-click the color you 
want to edit. 

Font 

Choose Font 

• To display the Choose Font dialog box, double-click the text icon. 

Align Left 

• To align text left, hold down the command key and type L. 

Align Middle 

• To center text, hold down the command key and type M. 

Align Right 

• To align text right, hold down the command key and type· R 



This section covers in a concise and detailed form every aspect 
of GS Paint. It's the place to find anything that isn't covered in 
the guided tour.· The "Reference" is organized by the way 
things appear on the screen: the tool, border, and color/pattern 
palettes are illustrated and explained and the menu functions 
are listed according to the menu they appear on. 
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The Tool Palette 

The following illustration identifies each of the tools and explains 
its use. 

Hollow Rectangle 

Hollow Rounded Rectangle 

Hollow Free-form Shapes 

Hollow Polygon 

Marker Box 

Text 

Spray can 

Pencil 

Eraser 

Filled Rectangle 

Filled Rounded Rectangle 

Filled Oval 

Filled Free-form Shapes 

Filled Polygon 

Lasso. Select an image and lift it off its background to move, copy, 
or cut it. 

Marker Box. Select an area along with its background to move, 
copy, or cut it. 

Hand. Move a drawing around in the window. 

Text. Activate the keyboard so you can add text to a picture. 

Paint Bucket. Fill outlined or solid areas with a color or pattern. 

Spray Can. Spray a color or pattern. 
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Paintbrush. Paint with a color or pattern in any of 32 brush shapes. 

Pencil. Draw a thin line in a color or pattern. 

Straight Line. Draw a straight line; its color (or pattern) and 
width match the line selected on the Border Palette. 

Eraser. Erase whatever you drag it over. 

Hollow Rectangle. Draw the outline of a rectangle or square. 

Filled Rectangle. Draw a rectangle or square .filled with a color or 
pattern. 

Hollow Rounded Rectangle. Draw the outline of a rectangle or 
square with rounded corners. 

Filled Rounded Rectangle. Draw a rounded rectangle or square 
.filled with a color or pattern. 

Hollow Oval. Draw the outline of an oval or circle. 

Filled Oval. Draw an oval or circle .filled with a color or pattern. 

Hollow Free-form Shapes. Draw a closed outline of any shape. 

Filled Free-form Shapes. Draw any closed shape .filled with a 
color or pattern. 

Hollow Polygon. Draw the outline of a polygon. 

Filled Polygon. Draw a polygon .filled with a color or pattern. 

All hollow shapes match the color ( or pattern) and width of the line 
selected on the border palette. 
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All filled shapes are filled with the selected color (or pattern) and 
have an outline matching the color ( or pattern) and the width of the 
line selected on the border palette. 

The Color/Pattern Palette 

The color/pattern palette contains the colors and patterns you have 
to choose from in creating a picture. 

4:~i!"~:::WJ:,:,W:~S ~ 
Selected Color or Pattern 

Color of the Background 
Color or Pattern of Borders 

The Drawing . Window 

The drawing window frames the easel's working area. 

/Close Box /Title Bar 
.. 

untitled 
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About gives you the version number of your copy of GS Paint 
and other similar information. 

To use About: 

• Choose About from the Apple menu. 

A dialog box appears . 

• To go back to the easel, click the mouse button. 

Help 

Use Help for a brief summary of what tools the tool icons stand for 
and of the border and color/pattern palettes. 
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To use Help: 

• Choose Help from the Apple menu. 

The help information appears . 

• To go back to the easel, click the mouse button. 

Clock 

Use dock to display the current date and current time. Click 
the close box in the clock display to return to using GS Paint. 

File 

• IIImI Edit Goodies Color Font 

~ N~ IjN 
Open ... Ijo untitled 
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~ Close 
Saue ... Ijs 
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Occasionally, when you make a selection from the File menu, this 
dialog box may appear: 

Saue changes before closing? 

eYes 1 
~ 

( No ) (Cancel) 

It means you've made changes to the picture on the screen since 
you last saved it. The dialog box gives you a chance to save those 
changes. 

The three buttons in the box give you these choices: 

Yes. Click Yes, and a dialog box appears that lets you save the 
picture. Type a name for the picture if you need to, then click 
Save. Once you've saved the picture, the command you've 
selected is carried out. 

No. Click No, and the command you've selected is carried out 
immediately. The picture on the screen isn't saved, and you won't 
be able to get it back 

Cancel Click Cancel if you decide you don't want the command 
you've selected to be carried out. 
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New 

Use New to start a new picture on a new page. The color (or 
pattern), the border, and the currently selected tool are left 
unchanged. The Clipboard is also left as it is. You can't undo New 
once it has been carried out. 

To use New: 

• If there's a picture on the screen you want to keep, first save it, 
then close it. 

• Choose New from the File menu, or hold down the command key 
and type N. 

A clean page appears so you can start a new picture. (If a dialog box 
appears that asks Save changes before closing?, see the 
instructions at the beginning of the File section.) 

Open 
Use Open to redisplay a picture you've saved on a disk. You can't 
undo Open once it has been carried out. 

To use Open: 

• If there's a picture on the screen you want to keep, first save it, 
then close it. 

• Choose Open from the File menu, or hold down the command 
key and type O. 
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A dialog box appears. (If a dialog box appears that asks Save 
changes before closing?, see the instructions at the beginning of 
the File section.) 

• Click the name of the picture you want to open. 

The buttons in the box give you these choices: 

Open. Click Open to have the picture you've selected displayed 
in the drawing window. 

The picture appears in the drawing window. 

Close. You can't use Close. 

Disk If the picture you want to open is on a disk other than the 
one in the drive, put the new disk in the drive and then use Disk 
to display the names of the pictures on the new disk. 

Cancel Click Cancel if you decide not to open a picture. 

Close 

Use Close to remove a picture from the screen. It doesn't save the 
picture, nor does a clean page appear. You can't undo Close once it 
has been carried out. 

To use Close: 

• If you want to keep the picture you're about to close, save it first. 

• Choose Close from the File menu, or click the close box (at the 
left end of the title bar). 
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The picture disappears from the screen. (If a dialog box appears that 
asks Save changes before closing?, see the instructions at the 
beginning of the File section.) 

Save 

Use Save to make a copy of a picture on a disk. The patterns and 
colors in the palette are saved with the picture. If there's already a 
picture (or any other file) on the disk that has the same name as the 
picture, the picture erases it and replaces it. If you don't want to 
replace the old picture, use Save As to give the new picture a 
different name. (Save As is explained below.) 

You can also use Save to create a folder to save pictures in. Saving 
pictures in a folder is a convenient way to keep together pictures 
that are related (like those that make up an animated sequence). 

You can't undo Save once it has been carried out. 

To use Save: 

• Choose Save from the File menu, or hold down the command 
key and type S. 

A dialog box appears. 
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Free: 40/800Kb 
~--------riJ""" ( Disk) 

..=. ( New Folder ) 
'--

/...... "', 

".... .... ~!F~~.r.~ ............ ) 
~ ( Close ) 

Save As : [;;;( ;;;;;;;;;;;;sa;;;v;;e;;;;;;;;;;~] 
ull~im~dM'~t!ljI!'·!!!l. _____ JI ( cancel) 

@ Paint Format o Screen Format 

• Type a name for the picture in the space under Save As. 

The buttons in the box give you these choices: 

Disk If you want to save the picture on a disk other than the one 
in the drive, replace the disk in the drive with the new disk. Use 
Disk to display the names of the pictures on the new disk. 

New Folder. To create a new folder, type a name for it in the 
space under Save As, then click New Folder. Use Open to open 
the new folder whenever you want to save a picture in it. 

Open. If you want to save a picture in a folder, select the folder 
from the catalog and click Open. 

Close. You can use Close on a folder that is open. Use Close to 
close the folder. 

Save. Click Save when you're ready to save the picture. 
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If a dialog box appears that says Volume full, there isn't enough 
room on the disk to save the picture. Click OK, then eject the disk 
from the drive and replace it with a disk that has space on it. 

cancel Click cancel if you decide not to save the picture. 

You can save a picture in either of these formats: 

Paint Format If you create a full-page picture you intend to 
print a copy of, use Paint Format The entire page is then saved. 
(An entire page is 320 pixels wide by 396 pixels high.) 

Screen Format If you create a picture you intend to display only 
on the screen, use Screen Format Only part of the picture is 
saved: the part that's visible when you choose Full Screen from 
the Goodies menu. (The screen is 320 pixels wide by 200 pixels 
high.) 

Save As 

Use Save As to save different versions of the same picture. It allows 
you to give a new name to a picture you've already saved and then 
save the picture under the new name. As long as you give the new 
version a different name, Save As, unlike the Save command, 
doesn't replace the old picture with the new one. You can't undo 
Save As once it has been carried out. 

To use Save As: 

• Choose Save As from the FUe menu. 

A dialog box appears that's just like the one that accompanies the 
Save command. The functions of the buttons and the formats that 
are available are explained above. 



Reference 

Revert 

Use Revert to replace the picture on the screen with the last 
version you saved. Revert will undo all the changes. you've made 
to a picture since the last time you saved it; You can't undo Revert 
once it has been carried out. 

To use Revert: 

• Choose Revert from the Flle menu. 

A dialog box appears, asking if you want to revert to the last version 
saved. 

Heuert to the last uersion 
saued? 

« OK ) (cancel) 

The buttons in the box give you these choices: 

OK aick OK to replace the picture on the screen with the 
version that's on the disk. The drawing window goes blank, and 
after a moment the last version saved appears. 

Cancel Click Cancel if you decide you don't want to revert to 
previous version. 
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Print 

Use Print to make a printed copy of a picture. You can't undo 
Print once printing starts. 

There are three other print commands not listed on the File menu. 
You use one to print the version of a picture as it appears in the 
drawing window and another to print the full screen image. The 
third you use to print whatever is on the screen (including the 
palettes and the menu bar) to a disk rather than on your printer. 
You can then open the disk file and make changes to it just like any 
other picture. 

To use Print: 

• Choose Print from the File menu, or hold down the command 
key and type P. 

The other commands work like this: 

• To print the full screen image of a picture rather than the whole 
page, hold down both the command key and the shift key and 
type 4. 

• To print the part of a picture in the drawing window image 
instead of the whole page, hold down the command key and 
type 4. 
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• To print the screen to a disk, hold down the command key 
. and type 3 When you print the screen to a disk, you don't 

name the pi'cture that's being saved yourself as you do with 
the Save command. Instead GS Paint names the picture for 
you. It names the first one Screen 0, the next one Screen 1, 
and so on through Screen 9. If you print more than nine 
screens to a disk, GS Paint starts over after Screen 9 and 
names the tenth picture Screen O. Make sure you save 
pictures given the same name on different disks. Otherwise, 
the second Screen 0 will replace the first Screen 0, the 
second Screen 1 the first Screen 1, and so on. 

• To print the window that's active, hold down both the command 
key and the shift key and type 4. 

Quit 

Use Quit to leave GS Paint. You can't undo Quit once it has 
been carried out. 

To use Quit: 

• If you want to keep the picture that's currently on the screen, save 
it. 

• Choose Quit from the Flle menu, or hold down the command 
key and type Q. (If a dialog box appears that asks Save changes 
before closing?, see the instructions at the beginning of the 
Flle section.) 

The entire screen is erased, and you can start using another software 
program if you like. 
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Deleting a Picture from a Disk 

You can erase a picture from a disk if you don't want to keep the 
picture any longer. See your system disk guide for instructions. 

Edit 

DIIIIII 

o. 
oe 
c:?w 

Undo 

Inuert 
Flip Horiz. 
Flip Uert. 
Rotate 

Use Undo to cancel the last change you made to a picture. 

Note: You can't use Undo to cancel any of the commands on the 
File menu. 

To use Undo: 

• Pull down the Edit menu and click Undo; you can also hold 
down the command key and type Z; or press esc. 
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Examples: 

If you've been using the pencil, Undo removes everything you 
drew between last pressing and releasing the mouse- button. 

If you've been using the eraser, Undo puts back on the screen 
everything you erased between last pressing and releasing the 
mouse button. 

If you've just used Undo, using it again returns the picture to the 
way it was before you used Undo the first time. 

Cut 

Use Cut together with Paste to move a picture (or a part of one) 
from one place on a page to another place, from one picture file to 
another, or from a picture file to a document created with some 
other application. 

To use Cut: 

• Use either the marker box or the lasso to select the image you 
want to cut . 

• Choose Cut from the Edit menu, or hold down the command key 
and type X 

The picture you've selected disappears from the screen and is 
placed on the Clipboard. You can now go to the other location or 
file and use the Paste command to place the picture there. 

Note: The largest area you can cut at one time is the area of the 
drawing window. If you want to move an image larger than that, you 
have to move it in pieces. 
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Copy 

Use Copy to make as many copies of an image as you want. 

To use Copy: 

• Use either the marker box or the lasso to select the image you 
want to copy. 

If you want to copy an image, but not the background it's on, use 
the lasso to lift it off the background before you copy it. 
"Background" has a special meaning. It means only the true 
background color - not any color that happens to be in the 
background behind an image. The true background color is the 
color surrounding the box on the palette where the selected color 
or pattern appears. 

~ . 
: 

'" "'. True background color 

• Choose Copy from the Edit menu; you can also hold down the 
command key and type C, or hold down the command key and 
click the selected area. 

A copy of the picture you've selected is placed on the Clipboard. 

• To insert a copy of the picture, use the Paste command. 

Note: For other ways to make copies, see "Copy" in the 
"Shortcuts" section. 
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Paste 

Use Cut together with Paste to move an image from one place on 
a page to another place, from one picture file to another, or from a 
picture file to a document created with some other application. If 
you want to move a copy of an image instead of the original image 
itself, use Copy instead of Cut 

If you paste an image you've cut or copied from one picture to 
another, the colors in the pasted image will change to the colors in 
the palette of the new picture if they're different from the colors in 
the palette of the original picture. 

• First select the image you want to move, and then use Cut or 
Copy. 

• Go to the place you want to move the picture to. You can go to 
another part of the same picture, another picture, or to a GS Write 
document. 

• Choose Paste from the Edit menu, or hold down the command 
key and type V. 

Repeat the last two steps if you want to insert the image in more 
than one place. The image stays on the Clipboard until you cut or 
copy another image. 

Clear 

Use Clear to erase from the drawing window an area or image 
you've selected. 
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To use Oear: 

• Use the marker box or lasso to mark the area you want to erase. 

• Choose Clear from the Edit menu, or press delete. 

The area you've selected is erased. 

Invert 

Use Invert to change the colors in an area you've selected to their 
palette complements. A color's palette complement is different from 
its true complementary color because it's determined entirely by the 
color's position in the palette. The complement of, say, the fourth 
color from the left end of the palette is the fourth color from the 
right end. 

Note: A color has an inverse, but a pattern doesn't. If you use the 
Inverse command on a pattern, the colors in the pattern change, 
not the pattern itself The pattern will look different only because 
the colors are different. For example, the inverse of a black and 
white pattern looks like the original pattern's negative. 

To use Invert: 

• Use the marker box (not the lasso) to select an area. 

• Choose Invert from the. Edit menu. 
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Flip Horlz. 

Use Flip Horlz. to change a selected area to its mirror image. After 
the area has been flipped, it's reoriented, but not repositioned, in 
relation to the rest of the picture. 

o Hands o Hands 

r------=-tiT-1 
! : 
! 0 • ! 
t _________________________ J 

To use Flip Horlz.: 

• Use the marker box (not the lasso) to mark the area you want to 
flip . 

• Choose Flip Horlz. from the Edit menu. 
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Flip Vert. 

Use Flip Vert. to flip an image over from top to bottom. 

o Hands 

o Hands 

f----~---l 
, , , , 
:. : , , !.. _________________________ J 

Everything that's on the right stays on the right; everything that's on 
the left stays on the left. The image is reoriented, but not 
repositioned, in relation to the rest of the picture. 

To use Flip Vert: 

• Use the marker box (not the lasso) to mark the area you want to 
flip . 

• Choose ;Flip Vert. from the Edit menu. 

Note: Flipping an image vertically isn't the same as rotating it 
twice. See "Rotate," following. 
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Rotate 

iiD Hands 

~D Hands iiD Hands 

Hands 

Use Rotate to change the orientation (not the position) of an 
image by rotating it a quarter turn counterclockwise. 

To use Rotate: 

• Use the marker box (not the lasso) to select the image you want 
to rotate. 

If the image is off center in the marker box, it will be off center 
after it's rotated. 

• Choose Rotate from the Edit menu. 

The area within the marker box is rotated a quarter turn 
counterclockwise. 
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Goodies 

Grid 

Show Page 
Full Screen 
Brush Shape 
Brush Mirrors 
Edit Pattern 
Compress 
Show 

Use Grid to activate an invisible grid over the page. The grid is 
made up of a series of horizontal and vertical lines that intersect 
every eight pixels. 

~ 
t 
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The grid helps you draw and align certain objects. When you draw 
with the grid on, you'll notice that lines and figures snap into 
position along the grid. The grid acts as a guide that lets you 
position points only where the lines of the grid intersect, and it lets 
you align the marker box and the shapes only with the lines of the 
grid. The grid affects the positioning and movement of the marker 
box, text, the line, hollow or filled rectangles, hollow or filled ovals, 
and hollow or filled polygons. It doesn't affect the lasso, the paint 
bucket, the spray can, the brush, the pencil, or the hollow and filled 
free-form shapes. 

Examples: 

: : : : : : : : : : : : : : : : : : 

~!.;j.;1 
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~rJIl:~~!t~;~ll~~j~tIIt-!-
The sides of a triangle don't have to follow the lines of the grid, but 
the triangle's points can only be at points where the lines of the grid 
intersect. 

109 



Reference 

EfffffffffffTffffffIJ 
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Neither the circumference of a circle nor the perimeter of an oval 
will follow the grid, but the sides of a rectangle touching the. top, 
bottom, left, and right edges of a circle or oval can lie only along the 
lines of the grid. 

~:::!:::!:::!:::~:::!:::!:::!:::!:::!:::~ 

~:::~::'.;':'i.::~:::~:::~:::~::t::~:::~ 

fl!tt~!j~i~!~j 
A line drawn with the line tool does not have to lie along the lines 
of the grid, but its beginning and end points can be only at 
intersections of the lines of the grid. 

To use Grid: 

• Choose Grld from the Goodies menu. 

A checkmark appears next to Grld on the menu. 

The appearance of the drawing window doesn't change, but the 
grid is now active. 

• To remove the grid, choose Grld from the menu again. 
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FatBits 

Use FatBits to display a small part of a picture in detail so you can 
work on it pixel by pixel. 

To use FatBits: 

• Use the marker box or lasso to mark the part of the picture you 
want to see in detail. Or position the pencil on the part of the 
picture you want to enlarge, hold down the command key, and 
click. 

• Choose FatBits from the Goodies menu, or double-click the 
pencil icon. 

• Use the pencil to draw a single pixel at a time. 

Click the pencil, and it draws a dot in the color that's selected. If 
the pencil is on a pixel in the selected color, a click removes the 
color. 

You can use any of the other tools when you're working on a 
picture in detail. 

• To go back to the normal view of the picture, choose FatBits 
from the menu again, or double-click the pencil icon again. 

Show Page 

Use Show Page to see the entire 8-by-1O-inch page your picture is 
on instead of just the part in the drawing window. 

To use Show Page: 

• Choose Show Page from the Goodies menu, or double-click 
the hand icon. 
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The rectangle on the page shows the part of the picture that's in 
the drawing window. You can move the rectangle to any part of 
the picture, and that part appears in the drawing window . 

• Click OK when you've positioned the rectangle over the part of 
the picture you want in the drawing window. 

The drawing window reappears. 

• Click Cancel instead of OK if you change your mind about 
repositioning the drawing window. 

Full Screen 

Use Full Screen to remove the drawing window, the menus, and 
the tool, border, and color/pattern palettes from the screen so you 
can use the entire screen to display a picture. You can't make any 
changes to the picture when you're using the entire screen to 
display it. 
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To use Full Screen: 

• Choose Full Screen from the Goodies menu. Everything but the 
picture itself is removed from the screen. 

• To go back to the drawing window, press the spacebar. 

Brush Shape 

Use Brush Shape to select a different shape for the paintbrush. 

To use Brush Shape: 

• Choose Brush Shape from the Goodies menu, or double-click 
the paintbrush icon. 

-

• • / '\. 

• • / "-

• • / " 
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c:J • ~ 
, 

The Brush Shape dialog box appears. A box marks the current shape 
of the brush. 

• Click the shape you want to use. The Brush Shape dialog box 
closes automatically. 

Note: If you want to leave the Brush Shape dialog box without 
changing the shape of the brush, click the current shape. 
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Brush Mirrors 

Use Brush Mirrors to paint two, four, or eight symmetrical brush 
strokes with a single movement of the paintbrush. Each of the brush 
strokes is a mirror image of the one you make with the paintbrush. 
You can set up a brush mirror in any or all of four places: 

Down the middle of the window (from top to bottom) . 
. Whatever you draw on the left side of the window is mirrored on 
the right side, and vice versa. 

§ 
Across the middle of the window (from left to right). 
Whatever you draw in the lower half of the drawing window is 
mirrored in the upper half; whatever you draw in the upper half is 
mirrored in the lower half. 
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Through the window from upper left to lower right. 
Whatever you draw in the lower left half of the window is mirrored 
in the upper right haltand vice versa. 

Through the window from lower left to upper right. 
Whatever you draw in the upper~left half of the window is mirrored 
in the lower right half, and vice versa. 

When you use diagonal mirrors, sometimes the mirror image of 
what you're drawing will fall outside the drawing window. If that 
happens, the mirror image. won't be drawn. 

A mirror is part of the drawing window, not part of the picture. If 
you move the picture in the drawing window, the mirror doesn't 
move with it. 



Reference 

To use Brush Mirrors: 

• Choose Brush Mirrors from the Goodies menu. 

--------
---- -

« OK )) 
.................. . .. "" 

'. . ......... .... 

* ( None) 

• Click the lines that match the places where you want mirrors set. 
If you want to set all the mirrors, click the center, where all the 
lines cross . 

• Click OK 

• Select the paintbrush and start drawing. 

• To remove a mirror, choose Brush Mirrors from the menu 
again and click the line that matches it. To remove all the mirrors, 
click None. 

Note: You'll find that the more mirrors you've selected, the 
slower you have to draw to get good results. 
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Edit Pattern 

Use Edit Pattern to change the patterns in the palette at the 
bottom of the screen. In most cases, the only way to create a pattern 
with color in it is by using the Edit Pattern function. 

To use Edit Pattern: 

• Select the pattern you want to edit from the palette. 

• Choose Edit Pattern from the Goodies menu, or double-click 
the pattern you want to edit (if you double-click the pattern, you 
don't have to select it first). 

• • • • • • •••• • • • • • • 

••••••• • •••••• • •••••• . ...... ~ • •••••• • •••••• • •••••• 

10111111111 
( OK ) tt ( Cancel) 

The Edit Pattern dialog box appears. 

The pointer works like this: 

If you want to erase a pixel, select white from the palette in the Edit 
Pattern dialog box, then position the pointer on the pixel and click. 
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If you want to add color to a pattern, select the color from the 
palette in the Edit Pattern dialog box, then position the pointer and 
click. You can remove a pixel you've just added by clicking a 
second time. 

You can also use the pointer to draw a line just as you do with the 
pencil in the drawing window. 

• Click OK to replace the old pattern with the new one. 

• Click Cancel to keep the original pattern. 

Any pattern you create will be saved with any picture you use it on. 

Compress 

Use Compress to compress a series of pictures into a single file so 
they can be animated. 

To use Compress: 

• Create a series of pictures for your animated sequence; when you 
save them, give each of them the same name followed by a 
number that shows the picture's place in the series (for example, 
BALLlO, BALL20, and so on). 

• Close the drawing window. 

• Choose Compress from the Goodies menu. 

A dialog box appears, similar to the one that accompanies the 
Open command, asking you to select an image. 

• Choose the picture that is first in the series. 

• Click Open. 
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GS Paint animates the series. 

A dialog box then appears that lets you set the timing. 

Timing: 2 

• Move the box to the right to slow down the animation (you can 
move the box either by dragging it or by clicking the arrows at 
either end of the speed bar). The number above the speed bar 
shows how many thirtieths of a second separate each picture from 
the next. For example, 

2 = 2/30ths (or 1/15th) ofa second 15 pictures/second 

6 = 6/30ths (or 1/5th) of a second 5 pictures/second 

30 30/30ths or 1 second 1 picture/second 

• After you've adjusted the speed, click OK 
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A dialog box appears, like the one that accompanies the Save 
command, letting you save the animated sequence. 

• Click Save. 

Show 

Use Show to show the animation sequence you've created using the 
Compress command. 

To use Show: 

• Create an animation sequence using Compress. 

• If there's a picture on the screen, close it. 

• Choose Show from the Goodies menu. 

• From the dialog box that appears, choose the sequence you want. 

• Click Open 

The animated sequence runs. When it gets to the end, it 
automatically repeats. 

• To stop the animation, click the mouse button. 
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Color 
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Search Color 

Use Search Color to identify which parts of a picture match which 
colors in the palette. 

To use Search Color: 

• Choose Search Color from the Color menu. 

As soon as you move the cursor to the drawing window, it changes 
shape . 

• If you want to identify .the color in the palette that a specific part 
of the picture matches, move the cursor to that part of the picture. 

A rectangle appears over the color in the palette that matches the 
color in the picture .. 
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• If you want to identify all the parts of the picture that match a 
specific color in the palette, move the cursor to the color in the 
palette. (This approach works for all the colors in the palette 
except for the ones farthest left and farthest right.) 

All the parts of the picture that match the color flash off and on. 

To return the cursor to its normal function, click anywhere on the 
screen. 

Dispose Color 

Use Dispose Color to erase a color and replace it with another 
color everywhere it appears in a picture. 

To use Dispose Color: 

• Hold down the option key while you select the color you want to 
use to replace the color (doing so changes the background to the 
color you select). 

• Select the color you want to replace from the palette. 

• Choose Dispose Color from the Color menu. 

A dialog box appears to warn you that you can't undo the change. 

GS /Paint will not undo! 

( OK ) (Cancel) 



Reference 

The buttons give you these choices: 

OK. Click OK to replace the color. 

Cancel. Click Cancel if you've changed your mind. 

Color Palette 

Use Color Palette to change the colours in the palette. The 
color palette contains 16 colors. If you want to use colors 
different from the ones currently in the palette, you can choose 
others from the 4096 colors that GS Paint can produce. 

To use Color Palette: 

• Select the color you want to change from the palette. 

• Choose Color Palette from the Color menu, or double-click the 
color you want to change (you don't have to select the color first 
if you double-click it). 

The Color Palette dialog box appears. 

Working 
Color 

Spectrum 
Palette 
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The five vertical bars of color in the lower half of the screen are 
the color mixers. 

The three on the left each control one of the primary colors. The 
one on the left is for red, the one in the middle for green, and the 
one on the right for blue. Next to each of them is a color bar that 
shows the range of the intensities available, from brightest to black 
Don't confuse the brightness of a color with lightness. The 
brightest red is the reddest, most intense red. The lightest red is a 
little red mixed with a lot of white - in other words, a pale pink 

The two mixers on the right side of the dialog box control the 
shade - the lightnes~ or darkness - of a color. The mixer on the 
left makes the color lighter, the one on the right makes it darker. 

The working color reflects the positions of the sliders on the 
mixers. Every change in the position of the sliders produces a 
different working color. 

You can move the sliders up and down to change the amount of 
red, green, and blue in the working color or to lighten or darken it. 

The spectrum palette in the lower right corner displays the basic 
spectrum of colors: the primary, secondary, and neutral colors 
(brown, gray, white, and black). 

The palette that divides the screen in half is a copy of the one on 
the easel. 

I 
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Choosing a Color 

To scan the colors avcti1able, first position the pointer on the color in 
the spectrum palette that's closest to the color you want (for 
example, if you want khaki, position the pointer on brown). Hold 
down the mouse button. A dotted outline appears around the color. 
Drag the dotted outline to the working color box and release the 
mouse button. The color in the box changes to the color you've 
selected from the spectrum palette, and the sliders on the mixers 
take their positions for that color. 

Each of the mixers shows 16 variations on the color you've selected. 
For example, the green mixer shows 16 variations with more or less 
green mixed in. The lightness and darkness mixers show variations 
with more or less white mixed in. 

If you don't see the color you want, position the pointer on the 
variation closest to it, and drag the variation to the working-color 
box. When you release the mouse button, a different set of 
variations appears. 

To see what a color looks like on your picture, move the pointer to 
the window in the upper half of the screen. The pointer turns into a 
paintbrush, and you can draw on the picture there with perfect 
safety - whatever you draw will be automatically undone when you 
return to the drawing window. 
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When you've found the color you want, position the pointer on it 
and hold down the mouse button. Drag the dotted outline to the 
palette across the middle of the screen and replace one of the colors 
there with the new color. Everywhere you used the old color in the 
picture, it will be replaced by the new color. If you don't want any 
of the colors you used in the picture to be replaced, replace a color 
you haven't used in the picture. 

There are two changes to be wary of: changing the colors at the two 
ends of the palette - the colors preset to black and white .. If you 
replace white with another color, that color instantly replaces white 
as the background color of the easel. Don't replace white with black 
or the screen will become unreadable. Something similar will 
happen if you replace black with another color: that color will 
instantly replace black as the text and outline color of the easel. 
Don't replace black with white. If you happen to replace either 
color with a color that makes the screen unreadable, press the esc 
key to undo the change. 

When you've made all the changes to the palette you want to make, 
click OK to go back to the drawing window. 

The new palette will be saved when you save the picture you're 
working on. You can also save the palette separately in the Paleue 
Table (see "Palette Table", below, for instructions). 

To return to the drawing window without keeping any of the 
changes you've made, click Cancel 

Mixing a Color 

To mix a color, move the sliders on the red, green, and blue mixers 
up and down .. 
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Mixing colors is mostly a matter of experimenting until you get the 
mix you want, but it may help you to understand how the process 
works. 

When you mix colors using GS Paint, you're actually mixing 
light of different colors. Mixing light is different from mixing 
paint. The major difference is that of you mix all the colors of 
paint together, the result is black; when you mix all the colors 
of light together, the result is white. 

As the color chart below shows, the three primary colors of light are 
red, green, and blue. Mixing red and blue produces magenta, mixing 
blue and green produces cyan, and mixing green and red produces 
yellow. Mixing all three together produces white. 

To mix a color, move the sliders on the three color mixers up and 
down. You can move the sliders either by clicking the arrows or by 
dragging the slider with the pointer. 
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The mixers work like dimmers: if you move the slider to the 
bottom, you turn the color up as far as it can go; if you move the 
slider to the top, you turn the color off. 

Examples: 

To get white, turn up all of the hue mixers to their highest level. 
"White" light is made up of all the colors of the spectrum - all of 
which can be derived from the three primary colors, red, green, and 
blue. 

To get yellow, turn up the red and green mixers all the way, and 
turn the blue mixer off. 

To get green, turn the green mixer all the way up, and turn the red 
and blue mixers off. 

To get black, turn all the mixers off. Black means there's no light. 

You can also mix color with black and white patterns and create 
new patterns using any (or all) of the 16 colors in the palette. 

Palette Table 

Use Palette Table to save up to 128 palettes. 

To save a palette: 

• Make any changes to the screen palette using the Color Palette 
command. 

• Choose Palette Table from the Color menu. 
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• File Edit Goodies lad Font 

( OK ) 

( Cancel) 
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When the Palette Table dialog box appears, the palette you've been 
using is displayed at the bottom of the screen. 

• Scroll through the palette bank to find either a blank space 
of a palette you don't want anymore. Use palette number 00 
if you want the palette you're saving to be the one that 
appears on the easel whenever you start GS Paint. 

• Drag the palette at the bottom of the screen to the space where 
you want to store it. 

• Click OK to save the palette and return to the drawing window. 

• Click Cancel if you decide not to· save the palette. 

To get a palette from the palette table: 

• Choose Palette Table from the Color menu. 

• Scroll through the palette table until you find the palette you want. 
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• Drag it to the palette at the bottom of the screen. 

• Click OK to return to the drawing window with the new palette. 

• Click Cancel if you deCide not to get a palette. 

Font 
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CbooseFont 

Use Choose Font to change the font (or typeface), the font style, " 
and the font size you're using. The preset font is System, the font 
style is Plain, and the font size is 8. 

To change the font, font style, or font size: 

• Select Choose Font from the Font menu, or double-click the 
text icon. 
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-' File Edit Goodies Color 

Style Size 

v Plain v 8 
Courier Bold 10 
Douer Italic 12 

"- Geneua Underline 14 
Heluetica Outline 18 
Hollywood Shadow 24 

Other: @:J 
0 

To change the font, select the one you want from the list. You can 
scroll to see more choices. The font that's currently selected for use 
is highlighted. To change the font style, select the one you want to 
use. A check appears next to the one you've chosen. To choose a 
font size, either select a size from the list or type a number in the 
space to the right of Other. Not all the fonts look good in all sizes. 
The sizes that are recommended appear in boldface on the screen. 
If you enter a font size next to Other, it has to be between 8 and 39. 

• Click OK to return to the drawing window to add text in the new 
font, font style, or font size you've chosen. 

• Click Cancel if you decide not to change the font, font style, or 
font size. 

To add text to a picture: 

• Select the text icon from the tool palette. 
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• Move the I to the place where you want the text to appear. Click 
the mouse button to place the cursor there. Start typing. 

• If you've come to the end of a line and you want to continue 
typing on the next line, press return. 

• If you want to change the font, style, or size but continue typing 
on the same line, press enter. 

The text appears in the new font, style, and size. 

To change text that's already on the screen: 

• If you haven't pressed the mouse button or enter since you typed 
the text you want to change, select the font, style, or size you 
want to change to. The text you've typed will immediately change. 

• If you have pressed the mouse button or enter since you typed the 
text you want to change, erase the text, select the font, style, or 
size you want to change to, and retype the text. 

Note: If you're using an Apple II that has been upgraded to an 
Apple IIGS, there's no enter key on the keyboard. 

Align Left 

Use Align Left to put text on the screen in the standard way: when 
you type a character, it appears at the cursor's position, and the 
cursor moves one space to the right. If you change the alignment to 
middle or right, the text is re-aligned with the cursor's first position. 

To use Align Left: 

• Choose Align Left from the Font menu, or hold down the 
command key and type L. 
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• Select the text icon. 

• Move the I to the place on the picture where you want to add 
text. Click the mouse button to place the cursor there. 

• Type the text you're adding. 

Align Middle 

Use Align Middle to center text as you type it. If you change the 
alignment left dr right, the text is re-aligned with the cursor's first 
position. 

To use Align Middle: 

• Choose Align Middle from the Font menu, or hold down the 
command key and type M. 

• Select the text icon. 

• Move the I to the place on the screen where you want to add 
text. Make sure the cursor is in the middle of the space where you 
want the text to appear. Click the mouse button to place the 
cursor there. 

• Type the text you want to add. 

Align Rigbt 

Use Align Right to add text to a picture, starting at the point 
where you want the text to end. If you change the alignment to 
middle or left, the text is re-aligned with the cursor's first position. 



Reference 

To use Align Right: 

• Choose Align Right from the Font menu, or hold down the 
command key and type R 

• Select the text icon. 

• Move the I to the place on the screen where you want to add 
text. Make sure the cursor is at the spot where you want the last 
letter of the text to appear. Click the mouse button to place the 
cursor there. 

• Type the text you're adding. 
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active window 

The window that's in front of all the others; it's the window where· 
you're currently working. 

Apple menu 

The menu at the far left end of the menu bar, which appears when 
you select the Apple. From it you can choose Help. 

border 

The lines that form the hollow shapes, the outlines of the solid 
shapes, and the lines drawn with the straight line tool are borders. 
The line with the checkmark beside it in the border palette (in the 
lower left comer of the easel) determines the width and color or 
pattern of borders. 

button 

A symbol in a dialog box that you click to make something happen. 
To find out what a specific button does, see the name of the button. 

Cancel button 

The button in a dialog box that lets you leave the dialog box 
without carrying out.a command. 

caps lock 

After you press the caps lock key, any letter that you type appears in 
uppercase without your having to hold down the shift key. Press the 
caps lock key again, and the keyboard returns to normal. The caps 
lock key doesn't affect numbers or symbols. 
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Open and Save As ... dialog boxes and in the launcher window. 

check box 

The small box or circle next to an option in a dialog box that you 
click to select or cancel an option: for example, the circle next to 
Paint Format in the Save dialog box. 

choose 

To pick a command from a menu. 

click 

To position the pointer on something and then press and quickly 
release the button on the mouse. 

Clipboard 

The place where an image you've cut or copied is placed. The image 
stays on the Clipboard even after you've pasted it elsewhere in the 
document until you cut or copy another image. 

close 

To remove a window from the screen. 

close box 

The small square at the left end of the drawing window's title bar. 
Click it to close the drawing window. 
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command 

A command is a choice you make from a menu ( or a combination of 
the command key and a letter-or number on the keyboard) that 
causes some action to take place. 

command key 

The key you hold to make a tool work in a special way or that, 
when you hold it down while pressing another key, causes a 
command to take effect. 

cut 

To remove something from a picture by selecting it and then 
choosing Cut from the Edit menu. The image you cut is placed on 
the Clipboard. See also Clipboard. 

delete 

The key that moves the cursor backwards, erasing the character 
that's to the left of it. 

dialog box 

A box with a message that asks you for a decision or for more 
information. Sometimes the message informs you that you can't do 
what you're trying to do or warns you that what you're about to do 
will destroy some part of a picture. 

dimmed 

A dimmed command, menu selection, or option is one that appears 
gray rather than black. It means you can't use the item. 
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disk 

A disk is a small magnetic disc about three inches across housed in a 
plastic shell. You 'save the pictures you want to keep on it. 

disk drive 

The piece of equipment you put a disk in so that you can save 
pictures there and get them· back. 

drawing window 

The window that displays a picture. 

double-click 

To position the pointer on something and then to twice press and 
quickly release the britton on the mouse. 

drag 

To position the pointer on something and hold the mouse button 
down while you move the mouse. You release the mouse button to 
choose a menu item, when you're drawing a figure or line, or 
reached the location where you want to move an object. 

easel 

The working environment- the menu bar, the tool, border, and 
color /pattern palettes, .and the drawing window - that appear on the 
screen. 

enter 

A. key that confirms or terminates an entry or sometimes a 
command. Note: If you're using an Apple II that has been upgraded 
to an Apple IIGS, there's no enter key on the keyboard. 
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folder 

A file you create in which you can keep together pictures that are 
related (for example, pictures that make up an animated sequence). 

font 

A typeface - that is, a complete collection of letters, numbers, 
punctuation marks, and other symbols with a eharacteristic 
appearance. An example of a font is Geneva. 

font size 

The overall size of characters in text. Font sizes are given in pOints 
(for example, 12 point and 18 point). 

highlight 

To change the colQr of the background to make something stand out 
from the rest of a document. Highlighting usually shows that 
something has been selected or chosen. 

I 

The pointer you use to position the cursor when you add text to a 
picture. 

icon 

A simple, small picture that represents an object (such as a tool). 

launcher 

The program that gives you access to the entire Apple IIGS system. 
The launcher shows you a list of the files on the disk in the disk 
drive and lets you choose the one you want to start. 
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memory 

The place your computer stores information while you're working 
on the information. 

menu 

A list of commands that appears when you point to and press a 
menu title in the menu bar. You drag a menu to open it, then 
release the mouse button while a command is highlighted to choose 
that command. 

menu bar 

The horizontal strip at the top of the screen that contains menu 
titles. 

menu tide 

The name of a menu, which appears in the title bar. Pressing on the 
menu title causes the title to be highlighted and its menu to appear 
below it. 

option 

A key you use like the command key to make a tool act in a special 
way. 

paste 

To place the contents of the Clipboard - whatever was last cut or 
copied-in the drawing window. 

pointer 

A small shape on the screen that follows the movement of the 
mouse. The pointer can be an arrow, an I, or a set of cross hairs. 
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press 

To position the pointer on something and then hold down the 
mouse button without moving the mouse. 

return 

A key you use to carry out a command. You can also use it when 
you're adding text to a picture to move the cursor to the beginning 
of the next line. 

rounded rectangle 

A rectangle with rounded corners. 

save 

To store information on a disk. 

scroll 

To move a picture, a catalog, or a list in a window so that a different 
part of it is visible. 

scroll arrow 

An arrow on either end of the scroll bar. Clicking a scroll arrow 
moves the document or directory one line. Pressing a scroll arrow 
scrolls the document continuously. 

scroll bar 

The rectangular bar along the right of the active window. Clicking 
or dragging in the scroll bar causes the view of the catalog or list to 
change. 
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scroll box 

The white box in the scroll bar. The position in the scroll bar 
indicates the position of what's in the window relative to the entire 
list. 

select 

To designate where the next action will take place. You use the 
mouse techniques of clicking, double-clicking, and dragging to select 
something. You can also use the marker box and lasso to select a 
part of a picture. 

shift 

A key you use to make the tool you're using act in a special way. It 
also causes letters you type while you're holding it down to appear 
in uppercase and the upper symbol to appear when you type a 
numeric or symbol key. 

spacebar 

The long, unlabeled bar on the keyboard that you press to type a 
space. 

style 

A variation of a font: plain text, bold, italiC, underline, outline, and 
shadow. 

tide bar 

The horizontal bar at the top of the drawing window that shows the 
name of the picture in the window. 

window 

An area that displays a picture or information on the easel. 
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animation, 1, 71 
Apple menu, 83 

background, 48, 79, 102 
border palette, 12, 78 
Brush Mirrors, 114 
Brush Shape, 18, 81; 113 

catalog, 33 
changing patterns, 63 
Choose Font, 82, 130 
choosing colors for the palette, 65, 125 
Clear, 81, 103 
Clipboard, 50 
Clock,90 
Close, 80 93 
Closing a picture, 31 
Color menu, 82, 121 
color palette, 82, 123 
color/pattern palette, 13, 79, 88 
command key, 3 
Compress, 118 
Copy, 80, 102 
copying an image, 50 
cursor, 26 
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Cut, 80, 101 
cutting and pasting a selected area, 56 

deleting a picture from a disk, 100 
dialog boxes, 79 
Dispose Color, 122 
drawing in detail, 61 
drawing window, 14, 88 

easel, 8, 85 
Edit menu, 80, 100 
Edit Pattern, 81, 117 
eraser, 10, 16, 77 
erasing a picture from a disk, 100 

FatBits, 62, 77, 81, 111 
File menu, 79, 90 
filled shapes, 10, 36, 78, 87 
finding a color, 67 
Flip Honz., 52, 105 
Flip Vert., 52, 105 
folder, 94 
Font menu, 82, 130 
free-form shapes, 10, 41 
freehand drawing, 16 
Full Screen, 14, II? 

Goodies, menu, 18, 81, 108 
Grid,108 

hand, 9, 76 
Help, 89 
hollow shapes, 10, 36, 78,87 
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invert, 104 
inverting a selected area, 51 

lasso, 9, 47, 76 
launcher, 6 

marker box, 9, 45, 76, 86 
menus, 79 

Color, 82, 121 
Edit, 80, 100 
File, 79, 90 
Font, 82, 130 
Goodies, 18,81, 108 

mixers, 66, 124 
mixing a color, 69 
mouse, 3 
moving a selected area, 46 
moving an image to a GS Write document, 58 
Moving an image to another part of the page, 56 
Moving an image to another picture, 57 
Moving to another part of the page, 55 
Moving the picture in the drawing window, 54 

New, 79, 92 

Open, 79, 92 
opening a picture, 32 
ovals, 10, 78, 87 

paint bucket, 9, 23, 59, 86 
Paint Format, 30, 96 
paintbrush, 9, 17, 77, 87 
palette, 1 
palette complement, 51, 104 
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Palette Table, 68, 128 
Paste, 80, 101 
pencil, 9, 16, 77 
pixels, 61 
pointer, 8 
polygons, 42, 78 
Print, 80, 98 
printing a picture, 31 

Quit, 80, 99 

rectangles, 37, 78, 87 
Revert, 97 
rotating a selected area, 53 
rounded rectangles, 37, 78, 87 

Save, 29, 80, 94 
Save As, 29, 96 
saving a picture, 29 
Screen Format, 30, 96 
Search Color, 121 
selecting an area, 45 
shortcuts, 75 
Show, 120 
Show Page, 55,81, 111 
spectrum palette, 67 
speed bar, 73 
spray can, 9, 21,61,86 
starting GS Paint, 5 
straight line, 10, 77, 87 
stretching a selected area, 53 



text, 9, 25, 76 
tools, 9, 10, 76, 86, 

eraser, 10, 16, 77, 87 
filled free-form shapes, 10, 78, 87 
filled oval, 10, 78, 87 
filled polygon, 10, 78, 87 
filled rectangle, 10, 78, 87 
filled rounded rectangle, 10, 78, 87 
hand,9,76,86 
hollow free-form shapes, 10, 78, 87 
hollow oval, 10, 78, 87 
hollow polygon, 10, 78, 87 
hollow rectangle, 10, 78, 87 
hollow rounded rectangle, 10, 78, 87 
lasso, 47, 76, 86 
marker box, 9, 45, 76,86 
paint bucket, 9, 23, 59, 86 
paintbrush, 9, 17, 77, 87 
pencil, 9, 16, 77, 87 
spray can, 9, 21, 61, 86 
straight line, 10, 77, 87 
text, 9, 76, 86 

Undo, 20, 74, 100 
using color, 60 
using patterns, 60 
using the mouse, 3 

working windows, 64 
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International Solutions 90-Day Warranty 
International Solutions warrants to the original consumer purchaser of this computer 
software product that the recording medium on which the software programs are recorded 
will be free from defects in material and workmanship for 90 days from the date of purchase. 
If the recording medium is found defective within 90 days of original purchase International 
Solutions agrees to replace, free of charge, any product discovered to be defective within 
such period upon receipt at its Factory Service Centre of the product, postage paid, with 
proof of date of purchase. 

This warranty is limited to the recording medium containing the software program originally 
provided by International Solutions and is not applicable to normal wear and tear. This 
warranty shall not be applicable and shall be void if the defect has arisen through abuse, 
mistreatment, or neglect. Any implied warranties applicable to this product are limited to the 
90-day warranty period described above. If the recording medium should fail after the 
original 90-day warranty period has expired, you may return the sofrware programme to 
International Solutions at the address noted below with a cheque or money order for $10.00 
(Australian currency), which includes postage and handling, and International Solutions will 
mail a replacement to you. To receive a replacement, you should enclose the defective 
medium (including the original product label) in protective packaging accompanied by: (1) 
a $10.00 cheque, (2) abriefstatement describing the defect, and (3) your return address. 
EXCEPT AS SET FORTH ABOVE, THIS WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, 
WHETHER ORAL OR WRITTEN, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OR 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER 
REPRESENTATION OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR OBLIGATE 
INTERNATIONAL SOLUTIONS. IN NO EVENT WILL INTERNATIONAL SOLUTIONS BE 
LIABLE FOR SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGE RESULTING FROM 
POSSESSION, USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO 
PROPERTY AND, TO THE EXTENT PERMITTED BYLAW, DAMAGES FOR PERSONAL 
INJURY, EVEN IF INTERNATIONAL SOLUTIONS HAS BEEN ADVISED OF THE POSSIBIL TY 
OF SUCH DAMAGES. 

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY 
LASTS AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE LIMITATIONS AND/OR EXCLUSION OR LIMITATION OF 
LIABILITY MAY NOT APPLY TO you. THIS WARRANTY GIVES YOU SPECIFIC LEGAL 
RIGHTS,ANDYOU MAY HAVE OTHER RIGHTS WHICH VARY FROM STATE TO STATE. 

Warning 
Any attempt to duplicate this product may damage it. Such damage is not covered 
by the warranty. Please see above for complete warranty. Registered mail is 
recommended for returns. Please send to: 

WARRANlY REPLACEMENTS 

International Solutions 
64 Shepherd Street, 

Chippendale, NSW 2007 
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